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1.0 Introduction  
 
 
The Model 837 Delta T Azimuth Drive is a rugged and powerful rotary actuator drive that can be coupled to an 
Imagenex 837B Delta T Multibeam Profiling Sonar.  The two axes of rotation in this combined unit provide the 
capability to obtain accurate, high resolution range information in any direction.  In standard applications, profiles 
may be made in any direction by simply commanding the Azimuth Drive to rotate the attached profiling sonar 
anywhere in a circle.  The profiling sonar can then perform a cross-sectional scan before being  rotated to a new 
azimuth angle.  The Azimuth Drive uses the same Ethernet communications line and command structure as the 
Delta T head.  A single, simple to use PC compatible computer  program operates both.  
 
The system consists of an underwater sonar head connected by Ethernet directly to the drive, and a top end 
Junction box which is connected via Ethernet to a Windows PC type computer and 24 (48) Volt power supply.   
 
The Junction Box and the Azimuth Drive both contain a Patton CopperLink Ethernet Extender which is used to 
overcome the cable length limitations of the Ethernet interface specification. The Patton devices are transparent to 
the operation of the system. 
 
In the typical installation the power supply and PC are supplied by the customer. The cable which comes with the 
unit has an underwater mate-able connector for the sonar side, and a standard RJ45 connector for the Ethernet. 
The cable is currently made up with bare wires for power, red goes to positive, black to negative.  
 
 

 
Figure 1 - The Imagenex Azimuth Drive with Junction Box 
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2.0 Getting Started:  
 
The DeltaT Azimuth Drive was designed to be user friendly and simple to set up in the field. It is generally 
recommended however to perform a preliminary setup before heading out into the field. Refer to Sections 2.1.1  
through 2.1.3.2 for details on installation of the DeltaT system. 

2.1 Step-By-Step Start Up Guide 
 

1. Physically mount the sonar referring to Section  2.1.1 on Page 2 for details. 
2. Ensure the power supply is providing +24Vdc (+48Vdc upon request). 
3. Turn the power supply off. 
4. Connect the Red wire from the cable to the +ve connection on the power supply. 
5. Connect the Black wire from the cable to the -ve connection on the power supply. 
6. Connect the RJ45 (looks like a large telephone connector) to the PC’s network card. 
7. Plug the 8pin  underwater connector to the Junction Box. 
8. Connect the supplied 6pin female to 6pin female to the Junction Box and the Azimuth Drive. 
9. Referring to Appendix B – Ethernet Setup Guide , configure the network cards IP address. 
10. Turn on the power supply. 
11. Launch the DeltaT_Azimuth.exe program 

 
• If file playback is desired, use the menu command “File->DataFrom->File” . 
• If real-time operation is desired, use the menu command “File->DataFrom->Head” . 

 
2.1.1 Hardware Installation 
 
The Azimuth Drive has a built-in Pitch Roll and Heading Sensor. These are calibrated at the factory normalized 
with the sonar DOWN. If the Azimuth Drive is to be deployed with the sonar UP, The calibration must be re-done. 
Refer to “Appendix A – Azimuth Drive Orientation Calibration Procedure ” on Page 37 for calibration 
procedures. 
 
 
For producing sensible profiles of the seabed, the sonar head should be mounted with the transducers down (the 
transducers are in the gray plastic). Refer to Figure  3 for the transducer position setting for your installation.  If the 
transducer position setting is incorrect. The ‘up/down’ setting in software can be switched if the sonar must be 
mounted the opposite way. 
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Figure 2 - Orientation of the Azimuth Drive – Sonar = DOWN 

 
 
 

 
Figure 3 – Orientation of sonar head for XDCR = Down applications. 

Figure 3 ,above, shows the sonar head aiming towards the bottom. Use the Xdcr Position = Down  setting in the 
Azimuth drive menu. Refer to Section 3.2  on Page 9. 
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2.1.1.1 Sonar Profile Tilt Angle 
 
The DeltaT sonar may be mounted and various tilt angles by adjusting the mounting flange angle. 
Profile tilt-angles of 0 º, +10 º, +20 º and +30 º can be set via two socket head screws on the sonar head flange. 
Figure 4 below indicates the mount locations. 
 

 
Figure 4 - Hole positions for Tilt Angle Adjustment 

 
After adjusting the tilt angle physically, the user should enter of the corresponding profile tilt-angle into the “Profile 
Tilt Angle ” menu (refer to Section 3.8  on Page 15 for details). 
 
 
2.1.2 Electrical Connection 
 
The DeltaT Azimuth Drive system consists of an underwater sonar head connected directly to the Azimuth drive. 
The Ethernet signals from the Azimuth Drive and the sonar are fed into a Patton CopperLink device, which 
converts the Ethernet signals to run over long distances. These CopperLink signals (and the Power lines) are fed 
into the Junction Box where they are converted back to Ethernet, and to a Windows OS computer and a 48Vdc 
power supply. In the typical installation the power supply and PC are supplied by the customer. The cable which 
comes with the unit has an underwater mate-able connector for the sonar side, and a standard RJ45 connector for 
the Ethernet. The cable is currently made up with bare wires for power, red goes to positive, black to negative. The 
Azimuth Drive and Junction Box uses approximately 1A at 48Volts.  
 
2.1.3 Software Setup 
 
The requirements for the user supplied PC are: Windows XP©, an available Ethernet port, and at least 2 GHz 
Pentium IV processor. Standard software screen resolution is 1024x768. The sonar head needs to run with a 
static IP (Internet Protocol) address for both head and PC. The IP Address of the PC must be set to 192.168.0.X 
where X is any number between 3 and 254. Also set the subnet mask to 255.255.255.0. In Windows XP, these 
settings can be found in the ‘Network Connections’ item in the ‘Control Panel’. Click on properties of the LAN 
adapter, and properties of the TCP/IP. There is also a settings box for default gateway, but it can be left blank. The 
IP Address of the sonar head is fixed at 192.168.0.2 (optional IP Address’s can be specified at time of order) 
 
DeltaT.exe is a Windows program that controls, displays and records data from the DeltaT Sonar. The program 
uses a high speed Ethernet connection (10Mbps) to communicate with the Model 837 sonar unit. 
 
The installation of the software on the PC is straightforward. The executable is called DeltaT.exe .  It can be 
installed in it’s own directory, and run by double clicking, or you can create a shortcut from the desktop for it. We 
do not recommend using the “New Program Wizard” or any other installation program. The program may start up 
either in playback mode or in real-time mode. If it is in real-time mode and the sonar head is not connected there 
may be a delay before the prompt comes back. The menu item for selecting between real-time and file playback is 
called ‘Data From…’, it is located under the ‘File’ pull-down menu, which is the leftmost upper pull-down menu 
item, as shown in the screen capture in Figure 5. 
 

Note : There are several things that can cause lost or failed connection. One is that the user turned the 
sonar power off. The other is that the Ethernet connection is not configured correctly. 
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Figure 5 – Screen capture from DeltaT program (file playback). 

 
The bottom of the screen contains three rotary dial controls and a hand icon which acts as a Hold (or freeze 
frame) button. The Range knob controls the current acoustic operating range during real time operation. The Gain 
knob adjusts the amount of hardware amplification used in the receiver circuitry of the DeltaT sonar head. Adjust 
the Gain so that there is a minimum amount of Red displayed in the “Signal Level” window located in the lower left-
hand corner of the screen. This window is enabled via the Options menu.  During file playback the Range and 
Gain knobs are not active, they simply reflect the setting that was used during the recording of the real time data 
acquisition.  The Display knob is used to adjust the brightness of the sonar image (after the Gain has been 
adjusted).  As long as you are recording the data, you can play back with different display gains, and colors. 
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2.1.3.1 Basic Software Operation 
 
There are ten menus at the top of the screen (see Figure 5).  The File menu has the Data From… sub-menu to 
control whether the software is in real-time, or playback.  Record Start is for starting data recording (onto the PC’s 
hard drive) and supplies a Dialogue box for file name and location.  Playback supplies a Dialogue box for selecting 
a file for playback.  (data files are automatically given the extension ‘.837’). Copy Start is for copying  sections of 
files into a file with a different name, for subdividing long data-files, Save Screen  is a screen capture command 
which creates a .BMP bitmap image of the current screen for inclusion into documents etc. 
 
The Color Table pull-down menu is for changing display colors.  Single target detection is often best using the 
‘NORM HI’ color table, while images of the bottom with shadows are usually best viewed in ‘GREY’ or ‘BROWN-
YELLOW’.  These colors are for display only, the data can be played back with any color scheme if desired. 
 
The Setup menu contains the Xdcr Position setting (Up or Down), Measurement Units (Meters, Feet or Yards), 
enable/disable for Automatic filename generation when recording and a Sound Velocity user entry box. 
 
Under Options, there are ‘Grid’ (On or Off), Sector Size (30, 60, 90 or 120 Degrees), Beamwidth (Wide: 3deg, 
Normal: 1.5 deg, Narrow: 0.75 deg and Narrow Image: 0.75 deg), Beams (120, 240 or 480 display beams), 
enable/disable Beam Output to IPAddress_Output1 (located in DeltaT.INI) and Averaging (0 to 10 shots). While 
viewing the data in Sector Mode, ‘Remove Background’ can be used to display only the ‘moving’ targets of a static 
image. Press the ‘Build Reference’ button to begin generating a background reference image, then press ‘Store 
Reference’. The background reference image will now be removed from the current image to produce an image 
with only ‘new’ or moving targets, you can then add Persistence to display a trail behind the moving targets. Other 
Option menu items include Gain Equalization to normalize the gain across the image, a GPS Lat/Lng Track Plotter 
window, Signal Level and Diagnostics displays. 
 
To maximize the shot rate when recording to a .837 file, set the number of displayed beams to 120. This will not 
affect your angular resolution as the number of beams are used only for display purposes. The shot rate (or PRF) 
can be monitored via the Diagnostics page. This number is displayed in milliseconds (the lower this number is, the 
faster your update rate will be). When playing back the data file, you can select any number of beams. 
 
‘Com Ports’ is applicable if a GPS is to be connected to the computer as well.  GPS positions can be recorded into 
the data file and viewed in the Track Plotter window in real time (or playback). This information can be used for 
later mosaicing. 
 
The ‘Mode’ pull down menu controls the different display modes.  Again this does NOT affect the stored data so 
the data can be stored in SECTOR mode and played back in PERSPECTIVE mode if desired.  BEAMTEST 
MODE simply shows the data from the individual channels without processing them into an image.  The sonar will 
operate more quickly in this mode, but you can’t really see what it is looking at. 
 
Enable Profile mode to profile a cross section of the seabed. Profile Point Setup is used for enabling the digitized 
profile point detection. You can set the Minimum Range and Minimum Level for detection. Enabling the ‘Low Mix’ 
display type decreases the data level so it is easier to see the profile points. The profile points are output via 
Ethernet to a connected PC running Imagenex 3Dview.exe using the IP Address stored in “IPAddress_Output1” of 
the DeltaT.INI file, the points can also be saved to a separate profile point data file (.83P) via the ‘Record To 
Profile Point File...’ button. This operation can be performed in real time or during file playback. 
 
While viewing the data in Profile Mode, ‘Profile Waterfall’ can be used to display consecutive cross-sections of the 
sea floor in a depth vs. color window. To change the depth to color ratio, position the cursor over the small profile 
image at the left side of the display and left-click to change the start depth then right-click to change the span. 
 
The ‘Video’ pull down menu is used for displaying a video window from an optional video capture device such as a 
video camera plugged into a USB video converter (i.e. Adaptec AVC-1100 USB).  Sub-menus include ‘Open Video 
Window’, Change Video Format’, ‘Record Enable’, and ‘Video Recording Rate’  
 
The final pull-down displays information about the DeltaT software such as contact information and version 
number. Please provide the version number and date for any support assistance. 
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2.1.3.2 File playback 
To open a “.837” data file to playback, use the menu command “File->Data From…->File”. The playback speed 
and playback file position may be altered by using the slider bars in the toolbar. See Page 20 for details on the File 
Playback Bars. 
 
Once you open a sonar data file to playback, the operation of real-time sonar data acquisition will stop. You can 
open only one data file to play back at a time. But you can open another data file to playback during file playback 
by following the above procedure. 
 
You can once again change the operation back to real time data interrogation by using the menu command ““File-
>Data From…->Head”. The system will then close the opened data file and begin to acquire data from the sonar 
head..  
 

Note : Care must be taken to adjust the range, gain, and speed during real time operation as these 
settings are not able to be adjusted during file playback. The exception to this is the 2.5m range. This 
range is actually a 5m range in the sonar head and displayed as a 2.5m range in the DeltaT software. 
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3.0 Detailed Description of Menus  
 
The DeltaT program provides several convenient ways (menu commands, Dialogue boxes, and toolbar 
commands) to control the sonar unit’s operations, operating parameters and data display windows. 
 

3.1 File menu commands 
 
The File menu offers the following commands: 
 

 
Figure 6 – The File Menu 

Table 1 – The File Menu Items 

Data From… Use this command to switch between real time or file playback mode. If “Head” is 
selected, the DeltaT program will start to interrogate the sonar head to acquire data in 
real time. If “File” is selected, the DeltaT program will open the standard Windows 
“Open File” Dialogue box where the user can select a previously recorded DeltaT sonar 
data file (with the file extension .837) to play back.  
 

Record Start…  Use this command to save real-time sonar data to a .837 file. If the “Automatic 
Filenames (.837)” option is set (in the “Setup” menu), DeltaT will automatically generate 
the file name based on the active selection under the “Automatic Filename Type” (in 
the “Setup” menu).  
For more information on automatic file names, please refer to Page 11. 
 
DeltaT will continue interrogating the sonar unit for data and at the same time recording 
the data to your named file. While recording data, The menu item will change to 
“Record Stop”. Select this to stop recording the file. 
 

Playback File…  Use this command to open a previously recorded DeltaT sonar data file (with the file 
extension .837) to play back. The DeltaT program displays the “File Open” Dialogue 
box so you can choose which file you want to open. 
  

Fast Playback Use this command to quickly scan through a file. It advances the file progress in steps 
increments to allow a quick overview of the file to determine if further inspection is 
required. 
 

Use Realtime 
Playback Speed 

Use this command to playback a file at the same rate as it was recorded in real time. It 
adjusts the playback speed to simulate Ethernet communication and acoustic times. 
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Copy Start… Use this command to copy a section of a file during file playback to a new file. This is 

useful when viewing large files and only a section is needed. While copying data,  the 
menu item will change to “Copy Stop”. Select this to stop copying the file. 
 

Convert .837 Sonar 
File(s) to .83B 
Format… 

Use this command to convert a single or multiples files to a .83B file format, which 
contains processed beam data. Before using this command, the processing scheme 
must be setup. Please refer to Page 12 for further details. 
 

Save Screen… Use this command  to capture a .BMP bitmap image of the current screen for inclusion 
into documents etc. 
 

Exit Use this command to terminate your DeltaT program. The system will save your display 
layout, and sonar settings to a text file called DeltaT.ini. The next time the program is 
started, the system will load these settings from this file.  
 

 
 

3.2 Azimuth Drive Menu Commands 
 
The Azimuth drive menu offers the following commands: 
 

 
Figure 7 - The Azimuth drive menu 

 
The Azimuth drive menu is used to set / configure various Azimuth Drive specific parameters. 
 
Disable Azimuth Drive Not Available. 

 
Change Azimuth 
Angle… 

Invokes the “Change Azimuth Dialogue Box. Refer to Section  5.6 on Page 25 for 
details. 
 

Azimuth Drive 
Diagnostics 

Displays diagnostic information pertaining to the Azimuth Drive. Refer to Section  5.4 
on Page 24 for details. 
 

Azimuth Drive 
Orientation 

Provides the option for “Up” or “Down”. If the sonar is pointed towards the bottom, set 
this to down. 
 

Auto Azimuth… Invokes the “Auto-Azimuth Dialogue Box to begin an automatic scan. Refer to 
Section  5.5 on Page 24 for details. 
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3.3 Color Table Menu Commands 
 
The Color Table menu is used to change the sonar data color palettes for the sonar images. DeltaT uses colors 
(called a color table) to represent echo data strength (amplitude). For example, the Normal High intensity color 
table maps the echo data amplitude to 127 colors ranging from Black (low strength level) though blue, green, 
orange yellow white and red (highest strength level). 
 
The Color Table menu offers the following commands: 

 
Figure 8 – The Color Table Menu 

Table 2 – The Color Table Menu Items 

Normal High Standard color table used for mapping the echo data amplitude to 127 colors ranging 
from Black (low level), through Blue, Green, Orange, Yellow, White and Red (highest 
level). 

Normal Low Same colors as Norm Hi, but uses a lower color intensity. 
Green 127 shades of green. 
Grey 127 shades of gray (White on Black). 
Reverse Grey 127 shades of gray (Black on White). 
Brown/Yellow 127 mixed shades of brown and yellow. 
Green/Blue 127 mixed shades of green and blue. 
Green/Yellow 127 mixed shades of green and yellow. 
Blue 127 shades of blue. 
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3.4 Setup menu commands 
 
The View menu offers the following commands: 

 
Figure 9 – The Setup Menu 

 

Table 3 – The View Menu Items 

IP Address… Use this command to alter the destination IP addresses for communication to the sonar 
and the post processing software machine. This command does not alter the IP 
address of the sonar head. It simply lets the DeltaT software what the IP address of the 
sonar is. 
 

Xdcr Position Use this command to set the display orientation of the DeltaT program to match the 
physical orientation of the sonar head. If the “Xdcr Position” setting is incorrect, port-
side data will be displayed on the starboard and vice-versa. The ‘up/down’ setting in 
software can be switched if the sonar must be mounted the opposite way. Refer to the 
section on Hardware Installation on Page 2 for details.  
 

Units Use this command to change the display units to either Meters, Feet, or Yards. 
 

Automatic Filenames 
(.837) 

Use this command to enable the option to save real-time sonar data to a .837 file using 
automatically generated filenames. If this option is disabled, the standard Windows 
Dialogue box will prompt the user for input when recording a file. 
 

Automatic Filename 
Type 

 

If automatic filename generation is enabled, the file will be named according to the 
scheme selected here. The file names will be based on the system date and time as  
 

DDMMMYYYY-hhmmss.837 
or 

DDMMMYYYY-nnnn.837 
 

where ‘n’ will be incremented by one with each file created on the same date. 
 

Sound Velocity… This item will need to be altered if the known speed of sound is different than 1500m/s.  
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3.5 Options Menu Commands 
 

The Options menu offers the following commands: 
 

 
Figure 10 – Options Menu 

 

Grid Use this command to either view or hide the grid overlay on the sonar image. 
 

Sector Size Use this command to set the display sector size to either 30º, 60º, 90º, or 120º. This 
function simply changes the processing and the display. The full data set is still 
recorded to the file. It is useful when only a small sector is visually required, such as 
when narrowing in on a location. By moving to a smaller sector, the required processing 
is reduced which results in a higher frame rate. This function is very important for post 
processing operation and is discussed in greater detail in Section 7.4  on Page 35. 
 

Beamwidth Use this command to change the processing mode to “Wide” “Normal”, “Narrow”, and 
“Narrow Mixed”. This function is very important for post processing operation and is 
discussed in greater detail in Section 7.4  on Page 35. 
 

Beams Use this command to alter the number of beams used in the processing. This function 
simply changes the amount of processing required. The full data set is still recorded to 
the file. The higher the number of beams, the greater the angular resolution of the 
display and the greater the amount of processing required which will reduce the frame 
rate. This function is very important for post processing operation and is discussed in 
greater detail in Section 7.4  on Page 35. 
 

Averaging 
 

Use this command to apply various amounts of averaging to the displayed image. 
Adjust this amount to “smooth” the image display. For example, an average of ‘3’ will 
plot the average of the last 3 pings. 
 

Gain Equalization This option is generally used only for profiling applications. Enabling it will increase the 
gain towards the edges of the display window. This function simply changes the 
processing and the display. The full data set is still recorded to the file. 
 

Display Track Plotter Use this command to open another window, which displays the sonar (or the ship) track 
plotted according to the GPS provided latitude and longitude information. Left clicking in 
the track plotter window will zoom in the scale, while right clicking will zoom out the 
scale. 
 

Clear Track Plotter Use this command to erase the tracks in the track plotter window. 
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Signal Level This option enables the Signal Level window which will appear in the lower left corner of 
the screen. This window displays the raw data set from the sonar head with no 
processing. The gain must adjusted to ensure there is no red showing in the signal 
level window. This is very important as the gain setting is one of the few items other 
than range that can not be altered during file playback. Please refer to Page 4 for 
further details on gain settings. 
 

Diagnostics Display the Sonar diagnostics. See Section 5.3  on Page 22 for details about sonar 
diagnostic items. 
 

 
 

3.6 Com Port Menu  
The Com Port menu is only active in real time and is disabled during file playback. Selecting it will show the 
“ComPort Setup” Dialogue box as shown below in Figure 11. Set the options to match the capabilities of the 
attached GPS unit. Please refer to Section 6.0  on Page 26 for GPS details. 
 
 

 
Figure 11 – ComPort Setup Dialogue Box 
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3.7 Switches Menu Commands 
 
The Switches menu displays the Set Switches dialog box as shown below in Figure 12 
 

 
Figure 12 – The Set Switches Dialog Box 

 
Note that Range and Start Gain can be controlled via the main screen dials. Pulse Length and Multiplier should be 
left at the default setting. 
 
Range  Sets the operating range of the sonar. 

 
Start Gain 
 

Sets the sonar gain. 
 

Pulse Length 
 

Sets the pulse length of the sonar 
 

Multiplier 
 

This number is multiplied by the Pulse Length setting. 
 

Auto Pulse Length  Deselect to override the pulse length 
Frequency Adjust this change the operating frequency of the sonar. 240kHz to 260kHz 

in 5kHz increments. This may be necessary to remove noise caused by 
external devices. 

Transmit Enables or disables the sonar transmitter. 
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3.8 Profile Setup Menu Commands 
 
The Profile setup menu offers the following commands: 
 

 
Figure 13 – The Profile Setup Menu 

Other than Profile Point Setup and Grid Type, all menu command are deactivated when in sector mode. 
 
Profile Point Setup This command displays the Profile Point Setup Dialogue box which contains 

options for profile point detection. Please refer Section 7.2  on Page 27 for 
details. 
 

Profile Tilt Angle Used only for profiling sonars. This command displays the sonar tilt angle 
Dialogue box. It is used when the sonar is physically mounted in an 
orientation other straight down. Please refer to Section 7.0  on Page 27 for 
details pertaining to profiling. 
 

Display Altitude Used only for profiling sonars. This command displays the Sonar Altitude 
window. If profile point detection is disabled in the Profile Point Setup 
Dialogue box, The altitude will display ‘n/a’. Otherwise the altitude will display 
distance from the sonar head to the bottom in the units selected.  
 

    
 

Grid Type Displays either a rectangular grid with horizontal and vertical measurements 
enabled, or a circular grid with range and bearing measurements enabled. 
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3.9 Data Output Menu Commands 
 
The Data Output menu displays the Data Output dialog box as shown below in Figure 14 
 

 
Figure 14 – The Data Output Setup Dialog Box 

 
The data being output is sent to the IP address specified in the IP Address dialog box in the “Output IP Address” 
section please refer to Section 3.4 on Page 11. 
 
None  Disables all data output functions 

 
83A (Point Output) 
 

Profile points generated will be sent to the IP address.  
 

83B (Beam Output) 
 

Generated beams will be sent to the IP address.  
 

 
 

Generated beams will be recorded to a .83B file.  
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3.10 Video Menu Commands 
 
This Menu is only active if a video capture device is install before running the DeltaT software.  
The ‘Video’ pull down menu is used for displaying a video window from an optional video capture device such as a 
video camera plugged into a USB video converter (i.e. Adaptec AVC-1100 USB). 
 
 

 
Figure 15 – The Video Menu 

 
Open Video Window  
 

Opens a live video window 

Change Video Format 
 

Changes the video format 

Record Video Enable 
 

If this option is set, video information is recorded at the same time DeltaT 
data is recorded. 
 

Video Recording Rate… 
 

Sets the update rate at video is captured. 
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3.11 About Menu Commands 
 
The About menu displays the information window as shown below in Figure 16. It displays information about the 
DeltaT software such as contact information and version number. Please provide the version number and date for 
any support assistance. 
 

 
Figure 16 – The About Window 
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4.0 Controls and File Playback Dialogue  
4.1 Main Controls 
 
The bottom of the screen contains four rotary dial controls and a hand icon which acts as a Hold (or freeze frame) 
button. These tools provide quick mouse access to the most commonly adjusted settings used in the DeltaT 
program. 
 
During file playback the Range and Gain knobs are not active, they simply reflect the setting that was used during 
the recording of the real time data acquisition.   
 

 
Figure 17 – The Main Controls 

Table 4 – The Main Control Items 

Range 
 

The Range knob controls the current acoustic operating range during real 
time operation. 

Gain 
 

The Gain knob adjusts the amount of hardware amplification used in the 
receiver circuitry of the DeltaT sonar head. Adjust the Gain so that there is a 
minimum amount of Red displayed in the “Signal Level” window located in 
the lower left-hand corner of the screen. This window is enabled via the 
Options menu.   

Display 
 

The Display knob is used to adjust the brightness of the sonar image (after 
the Gain has been adjusted). 

Hold 
 

Hold icon places all communication and displays on hold. 
 

         
Normal     Held 
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4.2 File Playback Progress and Speed  
These slider bars are not available during real time operation. When a file is opened a file playback progress bar 
and playback speed bar window will appear. Use these items to adjust the rate of file playback and location within 
the file to view. 
 

 
Figure 18 – The File Playback Progress and Speed Bars 

 
File Progress A slider bar with a pointer showing file playback position. Dragging the pointer to a new 

position will cause the file playback to start at that position. The slider range represents 
the file size.  

Play Back Speed A slider bar with a pointer showing file playback speed setting. Dragging the pointer to 
the right will speed up file playback.  
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5.0 Dialogue Boxes  
 

5.1 File Open Dialogue Box 
 
The following options allow you to specify which file to open: 
 
File Name Type or select the filename you want to open. This box lists files with the extension you 

select in the “List Files of Type” box.  

List Files of Type Select the type of file you want to open: The supported file extensions are “.837” if 
opening a sonar data file. The “.837” file extension is the standard DeltaT recorded file 
format. 

Directories Select the directory in which DeltaT control software stores the file that you want to 
open. 

 

5.2 File Save As Dialogue Box 
 
The following options allow you to specify the name and location of the file you're about to save sonar data into: 
 
File Name Type a new filename or select an existing file name to save sonar data into that named 

file.   

List Files of Type Select the type of file you want to save: The supported file extension is “.837  
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5.3 Diagnostics Dialogue Box 
 
The Diagnostics Dialogue Box is used to display important system variables. This Dialogue box is very useful 
when trouble shooting the system in real-time.  
 
 

 
Figure 19 – The Diagnostics Dialogue Box 

 

Table 5 – The Diagnostic Items 

Header Sent by the sonar to tell the program what kind of data format it sent, IUX is for DeltaT 
sonar image. From left to right, the indicators are: Data Format (IUX), Head ID (0x10), 
Status (0x40 = Status OK) 
 
Please refer to the Ethernet specifications document for further details. 
 

Type Contains various information on the type of sonar that is connected and it’s various 
capabilities. From left to right: Sonar Type, Transducer Type, Sonar Version 
 
Please refer to the Ethernet specifications document for further details. 
 

sonar time The first number contains the acoustic time for the current range. The second number 
contains the acoustic time subtracted from when the sonar is interrogated to when the PC 
receives it’s first reply. This number is dependant on the operating range. 
 

packet time The first number contains the time to receive the rest of the data packets for the current 
frame of data.  
 

proc time The time required to process the sonar data according to the options specified in the 
Options menu 
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plot  time The time that the program plot the sonar image to the display window. 

 
1/PRF The time required to complete one full frame of data including acoustic, communication, 

processing, and display. In file playback, this number will be less than real time as there 
are no communication and acoustic times. 
 

display Gain The first number indicates the current “Display” settings according to the “Display” knob. 
The second number (in brackets) indicates the “Display” settings from when the file was 
recorded. 
 

frequency Current operating frequency of the DeltaT sonar. 
 

average Current averaging setting as applied from the “Options” menu. 
 

beamwidth Current beamwidth setting as applied from the “Options” menu. 
 

beams Current beam setting as applied from the “Options” menu. 
 

velocity Current sound velocity as applied from the “Setup” menu. 
 

pitch If supplied with the optional Pitch, Roll, and Heading sensor, the pitch value for the current 
data frame will appear here. 
 

roll If supplied with the optional Pitch, Roll, and Heading sensor, the roll value for the current 
data frame will appear here. 
 

heading If supplied with the optional Pitch, Roll, and Heading sensor, the heading value for the 
current data frame will appear here. 
 

depth The depth value entered in the DeltaT.ini will appear here.  
 

IP Sonar The IP address of the sonar as applied in the “Setup” menu is displayed here. 
 

IP Output The IP address of the profile point or beam output as applied in the “Setup” menu is 
displayed here. 
 

Bytes Out The number of bytes sent out to the post processing machine are displayed here. 
 

Ext Trigger If supplied with the optional external trigger capability, the sonar sends up trigger status 
information for each data frame and is displayed here. 
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5.4 Azimuth Drive Diagnostics Dialogue Box 
 
The Azimuth Drive Diagnostics Dialogue Box is used to display important Azimuth Drive specific variables. This 
Dialogue box is very useful when trouble shooting the system in real-time.  
 
 

 
Figure 20 - Azimuth Drive Dialogue Box 

5.5 Auto-Azimuth Dialogue Box 
 
The Auto-Azimuth Dialogue Box is used to control important Azimuth Drive specific parameters. 
 

 
Figure 21 - Auto-Azimuth Dialogue Box 

Auto-Azimuth 
Enable 

Selecting this check-box will set the Azimuth Drive to automatically scan through the 
parameters described below. 

Azimuth Start Sets the starting location where the auto scan begins 

Azimuth Stop 
(CW) 

Sets the stopping location where the auto scan ends. The scan operates Clockwise. 

Azimuth 
Increment 

Specifies the step size in degrees for each sample. 

Generate DeltaT 
Sonar file (.837) 

After the current scan is complete a sonar file is generated in the standard .837 file format. 
 
 



 

Document Number: 430-024-00                                                                                                                                                     Page 25 of 83 

Generate Profile 
Point file (.83A) 

After the current scan is complete a sonar file is generated in the standard .83A file format. 

Generate ASCII 
file (.XYZ) 

After the current scan is complete a sonar file is generated in the standard .XYZ file 
format. 

 
 

5.6 Change-Azimuth Dialogue Box 
 
 
 
 
 
 
 
   
 
 

 
Clicking on the “Change Azimuth ” button will bring up the “Change Azimuth ” Dialogue Box. Select the desired 
azimuth angle and select “OK”. The Azimuth Drive will adjust to the specified location. 

 
Figure 23 - Change Azimuth Item 

 
Figure 22 - Change Azimuth Dialog Box 
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6.0 GPS Operations  
 
The DeltaT software has the capability to read GPS strings, plot the track of the vessel, as well as record the GPS 
information to the recorded file. 
  
In order to access GPS information, the DeltaT software needs to be told which com port is connected to the GPS 
unit. The Com Port menu is only active in real time and is disabled during file playback. Selecting it will show the 
ComPort Setup Dialogue box as shown in Figure 24. Set the options to match the capabilities of the attached GPS 
unit. 
 

Note : Windows XP© has certain “issues” with RS232 to USB adapters. Please refer to Appendix E – USB 
Data Converters and Windows XP© on Page 49 for important information on using these devices. 
 
 

 
Figure 24 – ComPort Setup Dialogue Box 

Although the ComPort Setup NMEA Position area only indicates GLL, GGA, and RMC strings, when using GLL, or 
GGA, ensure that the VTG string is present as certain information is not present in the GGA and GGL strings. If 
using RMC, however, the VTG string is not necessary. Once the GPS setup is complete, it may take awhile for the 
GPS device to detect satellites. Until the GPS begins sending GPS information to the DeltaT program, the GPS 
information area located in the lower right corner of the display will appear as shown in Figure 26. After GPS 
information is sent to the DeltaT program, the current Coordinates and speed will appear as shown in  

Figure 25. 
 
 
 
 
 
 
 

 
Figure 26 – No GPS information present 

 
 

Figure 25 – GPS information present 
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7.0 Profiling Operations  
 
In order to generate profile data for use in the Imagenex 3DView.exe software or various third party vendors 
(contact Imagenex for a list of partners), certain parameters need to setup before this can occur. This section will 
describe the procedure for generating profile data. 
 

7.1 Profiling Overview 
 
It is important to remember that the DeltaT software only displays one shot at a given time. Thus, it can be difficult 
to determine what is being displayed on the screen. To alleviate this, Imagenex has developed the 3DView.exe 
application which sequentially plots one frame at a time to “build up” an image over time. Please refer to the 
section on 3DView on Page 36 for details. 
 

7.2 Profile Point Setup    
 
Before beginning to generate profile points, the profile point destination needs to be setup. This is done in two 
places. The first is under “IP Address” in the Setup Menu as shown below in Figure 27. 
 

 
Figure 27 – IP Address Dialogue Box 

If the profile point are to be sent to 3DView running on another PC, set the “Output IP Address” to the address of 
that PC. If the profile point are to be sent to 3DView  running on the same PC, set the “Output IP Address” to  
 

127.0.0.1 
 
This special IP address is often referred to as the “Local Host ”. Now when profile detection, and data output, is 
enabled, the detected profile points are sent to the IP address set in the above Dialogue box. 
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7.3 Profile Point Setup    
 
In order to actually generate the profile points, the DeltaT software needs to know how to display the image 
(Profile Point Display), Whether to generate profile points or not and also where in the image to detect profile 
points (Profile Point Detection). Also, The DeltaT program has various filter settings (Profile Point Filter) to 
facilitate generating profile points on the desired type of data. 
 
 

 
Figure 28 – The Profile Point Setup  Dialogue 
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7.3.1 Profile Point Detection 
 
To enable profile point detection select the “Enable” radio button. The Minimum range box allows the user to begin 
profile point detection at a certain slant range below the sonar. Any data that is closer to the sonar than the 
minimum range setting will not generate profile data points. This is very advantageous if propeller wash is present 
in the data.  
 
There are two methods of setting the minimum profile depth and the maximum depth. The first is directly in the 
Profile Setup Dialogue Box as shown above. The second is locate the mouse at the top of the display until the 
mouse changes from the arrow to a vertical double-ended arrow similar to the one that appears when resizing a 
window. Left click the mouse and drag down. As the mouse is dragged, a gray-diagonally striped area will follow 
the mouse. Release the mouse button when the desired minimum range is set. Likewise, the same can be 
accomplished with the maximum depth except the starting point is at the bottom of the screen.  
 
Figure 29 shows the effects of maximum profile depth. In the top image, the maximum profile depth is set a point 
beyond the bottom return. Thus, profile points are generated on the bottom. In the bottom image, The maximum 
profile depth is set a point just at the bottom return. Thus, profile points are generated only on the part of the 
bottom that is less than the maximum depth setting. 
 

 
 

 
Figure 29 – Example of Maximum Profile Depth Adjustment 

 
Figure 30 shows the effects of minimum profile depth. In the top image, the minimum profile depth is set a point 
closer than the targets. Thus, profile points are generated on the targets. In the bottom image, The minimum 
profile depth is set a point just at the targets. Thus, profile points are generated only on the part of the targets that 
are farther away than the minimum depth setting. 
 

 
 

 
Figure 30 – Example of Minimum Profile Depth Adjustment 
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7.3.2 Profile Point Display 
 
This section of the Profile Point Setup Dialogue box sets the method for displaying sonar data on the screen. 
 
High Mix  
With High Mix, Image data is display at the normal intensity along with the generated profile points This shown 
below in Figure 31. 
 

 
Figure 31 – High Mix Example 

 
Med Mix  
With Med Mix, Image data is display at a reduced intensity along with the generated profile points. This shown 
below in Figure 32. 
 

 
Figure 32 – Med Mix Example 

Low Mix  
With Low Mix, Image data is display at further reduced intensity along with the generated profile points. This 
shown below in Figure 33. 
 

 
Figure 33 – Low Mix Example 

Points Only 
With Points Only, Image data is removed from the screen entirely and only profile points are displayed. This 
shown below in Figure 34. 
 

 
Figure 34 – Points Only Example 
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Artificial Bottom 
Artificial Bottom enabled is shown below in Figure 35. 
 

 
Figure 35 – Artificial Bottom with Low Mix Example 

 
7.3.3 Profile Point Filter 
 
Profile Point Filters enable the user to generate profile data focusing on certain areas of interest. By selecting 
various filter settings, the resulting profile data image can be altered significantly. This area is also covered more 
visually in the 3DView Section on Page 36. Using 3DView, the filtering results are much more apparent as it 
shows multiple pings at once rather than a “slice” of time as the DeltaT software does. 
 
First Return 
When First Return is selected, the profile points will be generated on the first target whose intensity is over a set 
threshold (and whose range is greater than the Minimum Range or Depth set by the user). The effect of this is that 
any objects in the water column will generate profile points. 
 

 
Figure 36 – First Return Filtering Example 
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Maximum Return 
When Maximum Return is selected, the profile points will be generated on the target whose intensity is the 
greatest for that beam (and whose range is greater than the Minimum Range or Depth set by the user). The effect 
of this is that any objects in the water column which generate weaker returns than the bottom will not generate 
profile points. 
 

 
Figure 37 – Maximum Return Filtering Example 

 
Bottom Following 
When the Bottom Following filter is selected, the profile points will be generated based on a determination on the 
bottom return. It attempts to “map” or “follow” the bottom in order to generate contours. The effect of this is that 
any objects in the water column which generate weaker returns than the bottom will not generate profile points. 
Also note that any small targets such as small rocks on the bottom will be ignored in order to approximate the 
bottom contour. 
 

 
Figure 38 – Bottom Following Filtering Example 
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7.3.4 Advanced Filter Settings 
 
This section is only available in DeltaT.exe v1.01.47 or higher. 
 
There are numerous filter parameters which can be changed when using the “Bottom Following” profile point filter. 
To change these parameters, select the Advanced Filter Settings button in the Profile Point Setup Dialogue box. 
 
 

 
Figure 39 – Profile Point Setup Dialogue box 

 
All Filter settings are active in real-time or during file playback, so experimentation with these settings will not 
affect the stored data. The various filter settings may need to be changed depending on the bottom type and/or if 
there are targets on the bottom or in the water column (i.e. rocks, shipwrecks, fish schools, pilings, etc…). 
 

 
Figure 40 – Advanced Filter Settings Dialogue box 
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Max Points 
the bottom detection filter detects up to “Max Points” and returns the range point  with the highest summed power, 
assuming the bottom echo contains the highest power. A maximum of 10 points can be detected, however a 
setting between 2 and 5 will generate good results. Use a setting of 1 to detect all targets in the water column. 
 
No. of Segments 
number of segments is used to help the filter work on complex bottoms (i.e. bottoms that are not flat). The bottom 
is divided into equal horizontal segments so the filter can act on smaller, less complex sections. Values between 3 
and 5 produce good results for typical bottom types. A value of 1 could be used for a very flat bottom. 
 
No. of Depth Bins 
not used at this time 
 
The following sequence is a good starting point for experimenting with the various parameters (check the result of 
each setting before moving to the next parameter): 
 
1. Fill between Beams  

- this setting generates a bottom range point for beams that don’t contain valid 
  range to bottom values. The detected range points from adjacent beams are used 
  for interpolating between the beams. 
 

2. Main Filter 
- the main filter smoothes the detected range points and positions the points in the 
  center of the returned pulse. This helps to generate a truer bottom profile specially 
  on the outer beams where the grazing angle is such that the returned pulse can be 
  scattered. 
 

3. Flat Bottom Filter 
- the flat bottom filter reduces bottom artifacts directly beneath the transducer. All 
  beams within +/-30 degrees of nadir are analyzed. Use this filter only if important 
  vertical features such as pilings or seawalls are not present. 
 

4. Remove short outliers  
- short outliers are unwanted targets above the bottom and in the water column. The 
  “% of range” entry sets the effective “height off bottom” setting for the filter. This 
  setting is entered as a percentage of the current range scale. For example, if the 
  current range scale is 20m, a value of 20% would mean that all targets higher than 
  4m above the bottom will be removed. A setting of 20% can be used for relatively 
  flat bottoms, lower settings can be used for very flat bottoms. Increase to 100% to 
  keep all water column targets. 
 
  Select “Show removed points ” to display the removed points as enlarged green 
  blocks (using the Norm Hi Color Table). Lower the “Background Level ” setting 
  to 0.1 or until the removed points are easily seen. This is a good diagnostic tool for 
  evaluating the short outlier removal filter. 
 

5. Along Track Averaging 
- this filter generates bottom ranges by averaging a number of consecutive pings. 
  It uses the same ping average setting as the Options | Averaging menu. Along 
  track averaging can be used with any of the above filters. 
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7.4 Processing Effects on Profile Data 
 
The type of processing performed on the raw data affects the resulting profile data greatly. It is recommended that 
the least amount of processing is performed during data acquisition as extra processing reduces frame rate, and 
thus reduces the quality of the final project. Think of it as digital photography. If while taking pictures of a football 
game, you pause between each picture to crop it, and rotate it, you will miss the big touch down. If, however, you 
simply take pictures as fast your camera will allow, you will get a great photo of that touchdown. You can always 
crop, and rotate that picture later. It is the same with sonar. Because the “raw” sonar data is always stored, you 
can post process the data at a later date. If the best quality data is desired, try and reduce the amount of 
processing to the minimum amount to get the job done. Then, during playback and profile generation, increase the 
amount of processing to improve the results. 
 
For example, in Figures Figure 41 through 42, The amount of processing was altered. The sonar head was run at 
30m range with Narrow Mixed processing. The first two indicate the effect of altering the number of beams only. 
With 480 beams being processed, the PRF was 121ms (8Hz). By changing the number of beams to 120, the PRF 
was reduced to 82ms (12Hz). By further reducing the processing required (setting the sector size to 60 degrees 
rather than 120 degrees, the PRF was further reduced to 71ms (14Hz). The sonar achieved an extra Six pings per 
second. Assuming a 3 knot cruising speed, The data collection rate went from ~5 pings per meter up to ~9 pings 
per meter. 

 
Note however, that these numbers are strictly for example only, and may or may not be reasonable in the field. 
Experimentation will need to be done to determine the minimum amount of processing to get the job done. 
 

 
Figure 41 – PRF Example - 480 Beams, 120deg Sector 

 
 

 
Figure 42 – PRF Example - 120 Beams, 60deg Sector 
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7.5 Profile inspection using 3DView  
 
It is important to remember that the DeltaT software only displays one shot at a given time. Thus, it can be difficult 
to determine what is being displayed on the screen. To alleviate this, Imagenex has developed the 3DView.exe 
application which sequentially plots one frame at a time to “build up” an image over time. This section 
demonstrates the effect of profile filtering using the 3DView images.  
 
First Return 
 
When First Return is selected, the profile points will be generated on the first target whose intensity is over a set 
threshold (and whose range is greater than the Minimum Range or Depth set by the user). The effect of this is that 
any objects in the water column will generate profile points. 
 
Bottom Following 
 
When the Bottom Following filter is selected, the profile points will be generated based on a determination on the 
bottom return. It attempts to “map” or “follow” the bottom in order to generate contours. The effect of this is that 
any objects in the water column which generate weaker returns than the bottom will not generate profile points. 
Also note that any small targets such as small rocks on the bottom will be ignored in order to approximate the 
bottom contour. 
 
The section of data shown below in Figure 43, is the same. The first was done using the First Return filter, while 
the second was done using the Bottom Following filter. The first image shows clearly the standing timber that was 
present, while the second clearly shows the bottom contour of where the trees were standing. 
 
The 3DView program provides the capability to zoom in and rotate the image to give varying perspectives of the 
data. The images below were rotated to illustrate the timber more clearly. Also, the bottom returns (where there 
were no trees) was masked off in the 3DView program to further isolate the trees. 
 

  
First Return      Bottom Following 

Figure 43 – Filtering Examples using 3DView.exe 
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Appendix A – Azimuth Drive Orientation Calibration Procedure  
 
The Azimuth Drive has a built-in Pitch Roll and Heading Sensor. These are calibrated at the factory normalized 
with the sonar DOWN. If the Azimuth Drive is to be deployed with the sonar UP, The calibration must be re-done.  
 

     
 

Pitch and Roll Calibration 
 
Set the Azimuth Drive in the desired position (UP or DOWN), and accurately level the drive in both the pitch and 
roll directions. Run the program “DeltaT_Azimuth_Drive_calibrate_pitch_roll.exe ”, and follow the on-screen 
instructions.  
 
Heading Calibration 
 
Set the Azimuth Drive in the desired position (UP or DOWN), Run the program 
“DeltaT_Azimuth_Drive_calibrate_compass.exe ”, and follow the on-screen instructions. Rotate the Azimuth 
Drive Clockwise . 
 
 

 

Figure 45 - Orientation of the Azimuth Drive – Sonar = UP 

 

Figure 44 - Orientation of the Azimuth Drive – Sonar = DOWN 
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Appendix B – Ethernet Setup Guide  
 
The Imagenex Model 837 DeltaT sonar system consists of an underwater sonar head connected via Ethernet 
directly (or indirectly) to a Windows © based computer. 
 
This document covers the necessary setup procedures to enable your Windows© XP© based PC to communicate 
with the sonar. 
 
Ethernet Cable 
The included Ethernet cable specifications are: 
 

• Cat 5e  
• RJ-45 
• 568B wiring scheme 

 
If this cable needs to be replaced, ensure that the above specifications are met.  
 

Configuration of Windows XP Ethernet Communications     
 
For the DeltaT system, the following Address’s are used 
 
PC  

IP Address 192.168.0.X 
Subnet Mask 255.255.255.0 

 
Where ‘X’ is a decimal number between 3 and 224. The number ‘1’ is reserved for a network server ‘2’ is reserved 
for the DeltaT sonar head, and 255 is reserved for broadcasting.  
 

The DeltaT sonar head has a default statically assigned IP Address of 192.168.0.2 .  
 
The Recommended PC’s IP address and Subnet Mask on the PC are: 
 

IP Address 192.168.0.3 
Subnet Mask 255.255.255.0 

 
On a Windows© XP© based machine, this is done as follows: 
 
1. Navigate the Control Panel and double click “Network Connections” 
2. Right click on the Ethernet interface you wish to connect with and select “Properties” 
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Figure 46 – Local Area Connection Properties Dialogue Box 

3. Select Internet Protocol (TCP/IP) and select “Properties” 
 

 
Figure 47 – TCP/IP Priorities Dialogue Box 

 
4. Enter the information shown above in Figure 47 and click “OK” to accept the changes.  
5. Click “OK” again to accept the changes.  
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Now your computer is on the same “Network” as the sonar head. When starting the DeltaT.exe program, the IP 
address stored in the “DeltaT.INI” file is read and a connection will be established. 
 

The sonar head has a statically assigned IP Address of 192.168.0.2 . Enter this number in the menu item  
“Setup -> IP Address”.  

 
The sonar head will run fine. However, if communication to the head does not function properly, try the 
suggestions located on Page 43. 

Sharing an Ethernet Device with the Sonar and Inter net 
 
If the computer will be using the same Ethernet card for both the sonar and Internet uses (NOT at the same time), 
set the card for the sonar using the above procedures. When using the Internet, you will need to reset the IP, 
Subnet, Default Gateway, and DNS Server to correspond to your Internet Service Provider. On most modern 
systems, this may be as simple as setting the system to “Obtain settings Automatically” This will set the computer 
to use the DHCP protocol. 
 
 

The DeltaT sonar head has a statically assigned IP Address of 192.168.0.2 . To re-use the sonar, the above 
procedures MUST be followed 

 
 

Setting up a Direct Connection 
 
This is the simplest way to connect to an Imagenex Ethernet Sonar System to a computer (PC) as shown in Figure 
48. In this configuration, there is simply a direct connection between the sonar and the operating PC. Note that the 
PC has a static IP address of “192.168.0.157”. 
 
 

Cat 5e

IP = 192.168.0.157

Sonar Device

IP = 192.168.0.2

 
Figure 48 – Connecting the Sonar via Direct Connection 
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Setting up a LAN 
 
To connect an Imagenex Ethernet Sonar System to a Local Area Network (LAN), refer to Figure 49. The 
advantage of this setup is that the sonar may be operated from any computer that is connected to the LAN. Note 
that the server computer must be running Windows© XP© PRO in order to set up a LAN. This is because only XP© 
PRO contains the necessary DHCP server component to auto-configure the client PC’s. The server also has a 
static IP address of “192.168.0.1” and no other PC on the network may have this IP. Currently, the sonar does not 
support DHCP  and is simply “piggy-backing” the network by using an IP that is on the same Subnet Mask as the 
LAN. 
 
 

HUB

Sonar Device

IP = 192.168.0.2

IP = 192.168.0.1

IP = 192.168.0.144 IP = 192.168.0.157

Server

Cat 5e

Cat 5e
Cat 5e

Cat 5e

 
Figure 49 – Connecting the Sonar via a LAN 
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Setting up a Networked LAN 
 
To connect an Imagenex Ethernet Sonar System to a networked Local Area Network (LAN), refer to Figure 50. 
This setup consists of two LAN’s interconnected via a router. The router acts as a server to the LAN that is directly 
connected to the sonar. The advantage of this setup is that the sonar may be operated from any computer that is 
connected to either LAN. The server has a static IP address of (for example) “172.16.0.1”. The router essentially 
has two sides. One side is configured as a client (“172.16.0.127”) and the other side is configured as a server 
(“192.168.0.1”). Currently, the sonar does not support DHCP  and is simply “piggy-backing” the network by using 
an IP that is on the same Subnet Mask as the LAN. 
 

HUB

Sonar Device

IP = 192.168.0.2

IP = 172.16.0.1

IP = 172.16.0.13 IP = 172.16.0.45

Server

172.16.0.127

192.168.0.1
Router

IP = 192.168.0.157

Cat 5e
Cat 5e

Cat 5e

Cat 5e

Cat 5e Cat 5e

 
Figure 50 – Connecting the Sonar through a multiple LAN 
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Appendix C – Patton 3241 G.SHDSL Router Configurati on 
 
Follow the steps in the Patton “Quick Start Guide ” to configure the IP address for the unit to match the network 
being used. For example if the sonar's IP address is 192.168.0.2, then the network would be configured as: 
 

Table 6 - Default IP addresses 

Device IP Address Subnet Mask 

Sonar 192.168.0.2 NA 

PC 192.168.0.3 255.255.0.0 

Patton connected to PC (Central unit) 192.168.0.10 255.255.0.0 

Patton connected to Sonar (Remote unit) 192.168.0.11 255.255.0.0 

 
Each Patton device must be configured separately using HyperTerminal 
 
Start Menu → All Programs → Accessories → Communications → HyperTerminal 
 

• Enter “superuser ” as Login 
• Enter “superuser ” as Password 

 

Ensure to type: 
 

 system config save  <enter>  
 

to save the IP address to flash. 
 

Service and G.SHDSL Configuration  
 

 To save the settings to the internal Flash memory, 
 Navigate to “System Configuration → Save” to Save current settings to flash.

 
 
Once the IP Addresses are configured, connect the remote unit to the computer via Ethernet and open a web 
browser. Type 192.168.0.11 in the Address Bar to connect to the remote units web configuration page. Enter 
“superuser ” as Login and “superuser ” as Password 
 

1. Navigate to “Services Configuration” → WAN 
2. Select “Create a new service...” 
3. Select “PPP bridged” 
4. Ensure the settings are as shown below. 
5. Navigate to G.SHDSL → Configuration 
6. Ensure the settings are entered as shown below to disable Error Control. 
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Figure 51 - Patton Central DSL Monitor Setup 

 

 
Figure 52 - Patton Central Line Options 

After Selecting “Configure & Activate”  wait for about one minute. 
 
 
 

1 

2 

3 

B 

1 

3 

2 
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 To save the settings to the internal Flash memory, 
 Navigate to “System Configuration → Save” to Save current settings to flash.

 
 
Disconnect the Remote unit from the PC and Connect the Central unit to the PC via Ethernet and open a new tab 
in the browser (or a new browser window). Type 192.168.0.10 in the Address Bar to connect to the central units 
web configuration page. 
 

1. Navigate to “Services Configuration” → WAN 
2. Select “Create a new service...” 
3. Select “PPP bridged” 
4. Ensure the settings are as shown below. 
5. Navigate to G.SHDSL → Configuration 
6. Ensure the settings are entered as shown below to disable Error Control. 

 

 
Figure 53 - Patton Remote DSL Monitor Setup 

 
 
 
 

1 

2 

3 
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Figure 54 - Patton Remote Line Options 

 

 To save the settings to the internal Flash memory, 
 Navigate to “System Configuration → Save” to Save current settings to flash.

 
 
Note the difference in Device Type  and Intended DSL Data Rate . The Remote unit is set for the MINIMUM Data 
Rate, while the Central unit is set for the MAXIMUM Data Rate. The Remote unit will up it's Data Rate to match the 
Data Rate of the Central unit. 
 
Navigate to the 'Home ” page for the Central Patton device. Leaving the Central unit connected to the PC, connect 
the cabling to the “Line ” ports on the units. It will take about a minute to set up the DSL link. 
 

1 

2 

3 

B 
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The home page will display something like: 
 

 
Wait until this is displayed: 
 

 
 

Navigate to the 'Home ” page for the Remote Patton device.  The home page will display the same. Ensure the 
DSL Link Rate Timeslot is the same for both the Remote and Central. 
 

 
 
Line Errors  
 
Navigate to G.SHDSL → Status 
 
If The Noise Margin  drops below an acceptable level, and/or excessive CRC Errors  are present, Adjust the data 
rate on the Central unit to a lower value in the G.SHDSL Configuration page. 
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Appendix D – Troubleshooting Communications  
 
Disable any network bridges that are present 

• A network bridge allows a separate port, such as “USB”, or “Firewire” to piggyback the Ethernet 
connection. 

• Under “Network Connections”, if there is a network bridge icon, disable it. 
 
Under “Network Connections”, right-click on the Ethernet card and select properties. 
 
Clear unnecessary network protocols 

• De-select all services except for “Internet Protocol (TCP/IP)” 
 
Remove any firewalls present (Note that Windows © XP© has a rudimentary firewall built into it. Disable this 
one first). 

• Select the “Advanced” Tab. De-select the Firewall option (if present). 
 
Click on “Configure” (in the “General” tab) and a new Dialogue box will appear. 
 
Set Link speed to “Auto” or “10Mbps” 

• In the “Advanced” tab, select  “Link Speed / Duplex Mode” and set to either “Auto Mode” or “10 Full Mode”. 
 
Disable any power saving that shuts down the Ethern et card. 

• In the “Advanced” tab, select “Link Down Power Saving” and set to “Disable”.  
• In the “Power Management” tab, de-select any power saving option. 

 
Repair the Ethernet connection. 
Windows remembers the hardware address for each socket. To clear the Windows settings: 

• Right click on the Local Area Connection.  
• Select “Repair”. 
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Appendix E – USB Data Converters and Windows XP©  
 
With the proliferation of the “Universal Serial Bus” (USB) compatible devices available for notebook and desktop 
computers, manufacturers are rapidly omitting physical serial ports on there products in order to cut production 
costs. The USB bus is extremely versatile as there are no Com Port conflicts, no IRQ's to deal with, and has 
support for up to 256 devices on one bus (while there are usually multiple USB ports on a computer, there are 
usually only two physical USB buses) . 
 
With all that is going for it, one would wonder why use serial devices at all. Good question. Major factors in 
retaining a true physical serial device are: 
 
Cable length – USB has a maximum cable length support of 5m (~16') 
Latency – USB is a packet driven technology and as such delays occur due to USB driver packaging schemes. 
 
 
Virtual Communication Ports  
 
To get a serial device (RS-232 or RS-485) connected to a computer that only has USB ports, a converter needs to 
be installed in-line between the USB port and the serial device. These converters install a special driver in 
Windows called a “Virtual Com Port” This software will emulate a serial port so that serial enabled software can 
simply “see” the USB port as a serial port. See the figure below for an overview. 
 

RS-232
Sonar ComX

Physical Data 
Converter

Virtual Com
Port Driver

RS-485
Serial

USB

USB

ComX
Sonar

Program

Computer running Windows OSPhysical Interfaces

 
Figure 55 – Overview of USB Data Converter Logic Flow 
 
One caveat is that Windows can get “confused” if a device is plugged into a USB port while there is data being 
transmitted through it. Windows thinks that the device is a "pen mouse" and the mouse cursor will behave 
erratically. If this happens, the computer will need to be restarted. To circumvent this phenomena, DO NOT 
connect GPS, or other devices to the USB adapter until the adapter is fully functional (i.e. plug the converter into 
the computer and wait until Windows sets it up and assigns it a Com Port number BEFORE plugging a serial 
device into the converter).  
 
Generally, once a converter is correctly installed, Windows will assign a Com Port number to A PARTICULAR  
device on A PARTICULAR  USB port. Once this is done, things run pretty smoothly....until the operator changes 
something.... 
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Common Windows © Issues related to all USB <--> Serial Converters 
 
This section is directed towards a USB device that is encoded with a serial number. If the USB is not encoded with 
a serial number, Windows will not assign a different Com Port number  for each device. It will still, however, assign 
a different Com Port number for each physical USB port. 
 
Windows XP will assign a Com Port number to a USB device when it is first installed in the system. However, it will 
assign a DIFFERENT Com Port number to the same device when it is plugged into a DIFFERENT USB port  on 
the same computer. To further complicate matters, Windows XP will assign a DIFFERENT Com Port number to a 
DIFFERENT device when it is plugged into the SAME USB port  on the same computer.  
 

Table 7 – Windows Com Port Assignment Scheme 

Converter USB Port

A A 4
A B 5

A A 4
B A 5

Assigned
Com Port

 
The table above indicates a possible scenario where various converters are plugged into various USB ports. The 
assigned Com Port numbers above are only for illustration purposes. Windows will actually assign the device the 
next available Com number. 
 
For example, If you first plug the device into the BACK USB port of the laptop, Windows will assign it a Com Port 
number of (for arguments sake) '4' When you start the DeltaT software, you set the GPS Com Port to '4', and it 
runs fine. The next time you use the device, you plug the same device into the SIDE USB port on the laptop. 
Windows will then assign the device a Com Port number of (again, for arguments sake) '5'. Now when you start 
the DeltaT software, it cannot open, or find, Com Port '4' as the device is now set to Com Port '5'. You set the Com 
Port in DeltaT to '5' and it again runs fine.  
 
There is no solution for this behaviour. It is a Windows function, and Imagenex has no control as to how the Com 
Ports are assigned to a device.  
 
Our suggestion is to only use the same USB port for each device. For example, only use the BACK USB port for 
GPS input.  
 
Also, if a different serial device is plugged into the same USB port, Windows will assign it a different Com Port 
again. For example, if Com Ports '4' and '5' are already taken, Windows will assign it Com Port '6'.  
 
To make a long story short. Windows assigns a specific Com Port to a specific serial device plugged into a 
specific USB port. If any combination changes, Windows will assign a different Com Port.  
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Determining the Assigned Com Port For All USB <--> Serial Converters 
 
This section describes various procedures for determining the assigned Com Port of a converter. This document 
assumes the Windows XP Pro operating system and other computers may appear differently. However, the 
procedures will be similar regardless of the Windows version. 
 
To access the Device Manager from the Desktop: 

1. Right click on “My Computer” 
2. Left click “Properties” 
3. Follow the following Illustrations to Set the Com Port Number of the Device. Note that these Illustrations 

are for the ATEN UC-232A Device. Also, Ignore the baud rate settings. Imagenex software automatically 
opens the port at the correct parameters. 

 

 
Figure 56 – System Properties 
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Figure 57 – System Properties - Select Hardware Tab 

 
Figure 58 – Device Manager – Select Ports and double click device 
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Figure 59 – Port Properties – Select “Port Settings” 

 

 
Figure 60 – Port Properties - Click "Advanced" 
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Figure 61 – Advanced Port Properties - Select Com Port Number 

 
Quick Tip  
 
To make a shortcut to the Device Manager on the Windows desktop: 
 

1. Right click on the Windows desktop 
2. Select “New” --> Shortcut 
3. Enter “devmgmt.msc” 
4. Select “Next” 
5. Enter “Device Manager” 
6. Select Finish 

 
 

 
Figure 62 – Creating a Device Manager Shortcut 
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Appendix F – Data Storage File Format (.837)  
 
When recording the sonar data to a .837 file, the following bytes are appended and saved to the file every 'shot': 
 
 

Byte # Description 
0 to 99 File Header  (100 Bytes) 
100 to 111 Sonar  Return Data Header  (12 Bytes) 
112 to xxxx  Sonar Return Echo Data 

(IUX mode: 8 * 1000 Bytes) 
(IVX mode: 16 * 1000 Bytes) 
xxxx  = 8111 or 16111 

xxxx+1 Sonar Return Termination Byte (always 0xFC) 
xxxx+2 
to yyyy  

Extra Bytes + Zero Fill 
yyyy  = 8191 or 16383 

yyyy+1 
to zzzz 

Video Frame (if available)  
 

 
 
FILE HEADER 
 
Bytes 0 through 99 contain the following File Header  information: 
 
Byte 0  ASCII '8'  
Byte 1  ASCII '3'  
Byte 2  ASCII '7'  
 
Byte 3  nToReadIndex  - Index for Number of Data Bytes 
   10 = 8000 Data Bytes (IUX data) 
   11 = 16000 Data Bytes (IVX data) 
 
Bytes 4-5 Total Bytes  - number of bytes that are written to the disk for this shot 
 

Byte 4 Byte 5 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
8192 (for IUX) or 16384 (for IVX) 

 
Bytes 6-7 nToRead  - Number of Bytes from the sonar 
 

Byte 6 Byte 7 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
8013 (for IUX) or 16013 (for IVX) 

 
Bytes 8-19 Date - null terminated date string (12 bytes) 
   "DD-MMM-YYYY" 
 
Bytes 20-28 Time  - null terminated time string (9 bytes) 
   "HH:MM:SS " 
 
Bytes 29-32 Hundredth of Seconds  - null terminated string (4 bytes) 
   ".hh " 
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Bytes 33-36 Video Frame Length  (if available) 
   length = 54 + (video_window_width * video_window_height * 3) 
 

Byte 33 Byte 34 Byte 35 Byte 36 
7 6 - 0 7 – 0 7 – 0 7 - 0 
1 Video Frame Length 

 
   Bit 7 of Byte 33 is set to 1 if video frame available. 
 
Byte 37  Xdcr Up/Down, Display Mode  
 

Byte 37 
7 6 5 4 3 2 1 0 
Rsvd Xdcr Reserved Display Mode 
    1 0=Dn 

1=Up 
  0 0 = Sector 

1 = Linear 
2 = Perspective 
3 = Profile 
4 = Beamtest 

 
Byte 38  Start Gain  
   0 to 20 in 1 dB increments 
 
Bytes 39-40 Profile Tilt Angle  
 

Byte 39 Byte 40 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
T [Tilt Angle (in degrees) + 180] * 10 

 
   If 'T' = 0, Tilt Angle = 0 degrees 
   If 'T' = 1, Tilt Angle = [((Byte 39 & 0x7F)<<8) | (Byte 40)]/10 -180 
 
Byte 41  Reserved 

always 0 
 
Byte 42  Reserved 

always 10 
 
Byte 43  Reserved 

always 0 
 
Byte 44  Pulse Length 
   Byte 44 = pulse_length/10 � 1-250 = 10 to 2500 microseconds 
 
Byte 45  Reserved 

Always 0 
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Bytes 46-47 Sound Velocity  
 

Byte 46 Byte 47 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
V Sound Velocity (in meters/second) * 10 

 
   If 'V' = 0, Sound Velocity = 1500.0 m/s 
   If 'V' = 1, Sound Velocity = [((Byte 46 & 0x7F)<<8) | (Byte 47)]/10.0 
 
Bytes 48-61 GPS Ships Position Latitude  – text string (14 bytes) 

“_dd.mm.xxxxx_N ” 
dd = Degrees 
mm = Minutes 
xxxxx = Decimal Minutes 
_ = Space 
N = North or S = South 

 
Bytes 62-75 GPS Ships Position Longitude  – text string (14 bytes) 

“ddd.mm.xxxxx_E ” 
ddd = Degrees 
mm = Minutes 
xxxxx = Decimal Minutes 
_ = Space 
E = East or W = West 

 
Byte 76  GPS Ships Speed  
   Speed = (Byte 76)/10 in knots 
 
Bytes 77-78 GPS Ships Heading 
 

Byte 77 Byte 78 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Heading * 10 (in degrees) 

 
Byte 79  Reserved 

Always 0 
 
Bytes 80-81 Operating Frequency 
 

Byte 80 Byte 81 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Operating Frequency (in kHz) 

 
Bytes 82-83 Pitch  
 

Byte 82 Byte 83 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
P Pitch 

 
   If 'P' = 0, Pitch Angle not available 
   If 'P' = 1, Pitch Angle = [((Byte 82 & 0x7F)<<8) | (Byte 83) – 900] / 10 
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Bytes 84-85 Roll  
 

Byte 84 Byte 85 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
R Roll 

 
   If 'R' = 0, Roll Angle not available 
   If 'R' = 1, Roll Angle = [((Byte 84 & 0x7F)<<8) | (Byte 85) – 900] / 10 
 
Bytes 86-87 Heading  
 

Byte 86 Byte 87 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
H Heading * 10 

 
   If 'H' = 0, Heading not available 
   If 'H' = 1, Heading = [((Byte 86 & 0x7F)<<8) | (Byte 87)]/10 
 
Bytes 88-89 Repetition Rate  – Time between pings 
 

Byte 88 Byte 89 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Repetition Rate (ms) 

 
Byte 90  Display Gain  
   0 to 100 percent 
 
Bytes 91-99 Reserved 

always 0 
 
SONAR RETURN DATA HEADER 
 
Bytes 100 through 111 contain bytes 0-11 of the Sonar Return Data Header  that is acquired directly from the 
sonar head (refer to the DeltaT Ethernet Interface Specification): 
 
Byte 100 ASCII 'I'  
Byte 101 ASCII 'U' or ASCII ‘V’  
Byte 102 ASCII 'X'  
Byte 103 Head ID 
Byte 104 Serial Status  
Byte 105 Packet Number  
Byte 106 Version  
Byte 107 Range  
Byte 108 Reserved  
Byte 109 Reserved  
Byte 110 Data Bytes (HI)  
Byte 111 Data Bytes (LO)  
 
SONAR RETURN ECHO DATA 
 
Byte 112 Start of Echo Data  
   IUX mode: 8000 byte block 
   IVX mode: 16000 byte block 
 
Byte xxxx End of Echo Data  
   IUX mode: xxxx = 8111 
   IVX mode: xxxx = 16111 
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SONAR RETURN TERMINATION BYTE 
 
Bytes xxxx+1 Termination Byte  – always 0xFC 
 
EXTRA BYTES + ZERO FILL 
 
Bytes xxxx+2 Sonar X-Offset  – 4 bytes, single precision IEEE floating point standard 
 
Bytes xxxx+6 Sonar Y-Offset  – 4 bytes, single precision IEEE floating point standard 
 
Bytes xxxx+10 Sonar Z-Offset  – 4 bytes, single precision IEEE floating point standard 
 
Bytes xxxx+14 Zero Fill  
to yyyy   IUX mode: yyyy = 8191  

IVX mode: yyyy = 16383 
 
VIDEO FRAME 
 
Bytes yyyy+1 Video Frame  (if available) 
to zzzz 
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Appendix G – 83A PROFILE POINT OUTPUT (.83A)  
 
 
DeltaT Azimuth – 83A XYZ OUTPUT  
 
( 83A UDP/IP Ethernet Datagram,  .83A File Format )  
 
For each ping, the following bytes are output during the 83A UDP datagram. If recording to a .83A file, the 
following bytes are appended and saved to the file for each ping. The total number of bytes ‘N’ for each ping will 
vary depending on the number of beams selected. 
 
 

Byte # Byte Description 
0-255 File Header  (256 bytes) 

256-nnn  XYZ for current ping  with Intensities 
 
nnn  = 256 + (14*number_of_beams) – 1                                  (3 floats + 2 bytes = 14 bytes) 

 
 
FILE HEADER 
 
Bytes 0 through 255 contain the following File Header  information: 

 
Byte 0 ASCII '8'  
Byte 1 ASCII '3'  
Byte 2 ASCII 'A' 
 
Byte 3 .83A File Version  
 0 = v1.00 
 
Bytes 4-5 Total Bytes ‘N’  - number of bytes that are written to the disk for this ping 

 
Byte 4 Byte 5 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
N = 256 + (14*number_of_beams) � Max = 6976 bytes (480 beams ) 

 
Byte 6 Azimuth Drive Status 
 Bit 0 =>  Orientation  
     0 = Down 
     1 = Up 
 Bits 1 – 7 Reserved = 0 
 
Byte 7 Reserved  - always 0 

 
Bytes 8-19 Sonar Ping Interrogation Timestamp  

Date – system date, null terminated string (12 bytes) 
 "DD-MMM-YYYY" 
 
Bytes 20-28 Sonar Ping Interrogation Timestamp  

Time  – system time, null terminated string (9 bytes) 
 "HH:MM:SS " 
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Bytes 29-32 Sonar Ping Interrogation Timestamp  
Hundredths of Seconds  – system time, null terminated string (4 bytes) 

 ".hh " 
 
 Note: see Bytes 112-116 for Milliseconds. 
 
Bytes 33-46 GPS Ships Position Latitude  – text string (14 bytes) 

“_dd.mm.xxxxx_N ” 
dd = Degrees 
mm = Minutes 
xxxxx = Decimal Minutes 
_ = Space 
N = North or S = South 

 
Bytes 47-60 GPS Ships Position Longitude  – text string (14 bytes) 

“ddd.mm.xxxxx_E ” 
ddd = Degrees 
mm = Minutes 
xxxxx = Decimal Minutes 
_ = Space 
E = East or W = West 

 
Byte 61 GPS Ships Speed  
 Speed = (Byte 61)/10 in knots 
 
Bytes 62-63 GPS Ships Heading 

 
Byte 62 Byte 63 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Heading * 10 (in degrees) 

 
Bytes 64-65 Pitch Angle (from Orientation Module)  

 
Byte 64 Byte 65 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
P (Pitch Angle*10) + 900 

 
 If 'P' = 0, Pitch Angle = 0 degrees 
 If 'P' = 1, Pitch Angle = [[((Byte 64 & 0x7F)<<8) | (Byte 65)]-900]/10 
 
 

Bytes 66-67 Roll Angle (from Orientation Module)  
 

Byte 66 Byte 67 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
7.5.1.1 (Roll Angle*10) + 900 

 
 If 'R' = 0, Roll Angle = 0 degrees 
 If 'R' = 1, Roll Angle = [[((Byte 66 & 0x7F)<<8) | (Byte 67)]-900]/10 
 

Bytes 68-69 Heading Angle (from Orientation Module)  
 

Byte 68 Byte 69 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
7.5.1.2 Heading Angle*10 

 
 If 'H' = 0, Heading Angle = 0 degrees 
 If 'H' = 1, Heading Angle = [((Byte 68 & 0x7F)<<8) | (Byte 69)]/10 
 

Bytes 70-71 Beams  
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Byte 70 Byte 71 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Number of Beams 

 
Bytes 72-73 Samples Per Beam  

 
Byte 72 Byte 73 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Number of Samples Per Beam 

 
Bytes 74-75 Sector Size  

 
Byte 74 Byte 75 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Sector Size (in degrees) 

 
Bytes 76-77 Start Angle  (Beam 0 angle) 

 
Byte 76 Byte 77 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
[Start Angle (in degrees) + 180] * 100 

 
 
 
 
 
 
 
 
 
 
 
 
 

Byte 78 Angle Increment 
 Angle spacing per beam = (Byte 78)/100 in degrees 
 

Bytes 79-80 Acoustic Range  
 

Byte 79 Byte 80 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Acoustic Range (in meters) 
 

Bytes 81-82 Acoustic Frequency  
 

Byte 81 Byte 82 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Acoustic Frequency  (in kHz) 
 

Bytes 83-84 Sound Velocity  
 

Byte 83 Byte 84 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
V Sound Velocity (in meters/second) * 10 

 
 If 'V' = 0, Sound Velocity = 1500.0 m/s 
 If 'V' = 1, Sound Velocity = [((Byte 83 & 0x7F)<<8) | (Byte 84)]/10.0 
 

 Start 
Angle  
 -60 
Degrees 

+60 
Degrees 
   Beam ‘n’      0 Deg 

 
 Sector Size 
120 Degrees 

Example: 
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Bytes 85-86 Range Resolution  
 

Byte 85 Byte 86 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Range Resolution (in millimetres) 
 

Bytes 87-88 Reserved  – always 0 
 

Bytes 89-90 Profile Tilt Angle  (mounting offset) 
 

Byte 89 Byte 90 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Profile Tilt Angle (in degrees) + 180 
 

Bytes 91-92 Repetition Rate  – Time between pings 
 

Byte 91 Byte 92 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Repetition Rate (in milliseconds) 
 
 

Bytes 93-96 Ping Number  – increment for every ping 
 

Byte 93 Byte 94 Byte 95 Byte 96 
7 – 0 7 – 0 7 - 0 7 - 0 

Ping Number 
 

Bytes 97-99 Reserved  - always 0 
 

Bytes 100-103 Sonar X-Offset  – 4-byte single precision floating point number 
 

Byte 100 Byte 101 Byte 102 Byte 103 
7 – 0 7 – 0 7 - 0 7 - 0 

Sonar X-Offset (in meters) 
 

Bytes 104-107 Sonar Y-Offset  – 4-byte single precision floating point number 
 

Byte 104 Byte 105 Byte 106 Byte 107 
7 – 0 7 – 0 7 - 0 7 - 0 

Sonar Y-Offset (in meters) 
 

Bytes 108-111 Sonar Z-Offset  – 4-byte single precision floating point number 
 

Byte 108 Byte 109 Byte 110 Byte 111 
7 – 0 7 – 0 7 - 0 7 - 0 

Sonar Z-Offset (in meters) 
 

Bytes 112-116 Sonar Ping Interrogation Timestamp  
Milliseconds  – system time, null terminated string (5 bytes) 

 ".mmm " 
 

Byte 117 Reserved  - always 0 
 

 
Bytes 118-119 Ping Latency  – Time from sonar ping interrogation to actual ping 

 
Byte 118 Byte 119 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Ping Latency (in units of 100 microseconds) 
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Bytes 120-121 Data Latency  – Time from sonar ping interrogation to 83A UDP datagram 
 

Byte 120 Byte 121 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Data Latency (in units of 100 microseconds) 
 
 Time Since Ping = Data Latency – Ping Latency 

Byte 122 Sample Rate 
 0 = Standard Resolution (1 in 500) 

1 = High Resolution (1 in 5000) 
 

Byte 123  Option Flags 
 Bit 0 – 1 = data is corrected for roll 
 Bit 1 – 1 = data is corrected for ray bending 
 Bit 2 – 0 
 Bit 3 – 0 
 Bit 4 – 0 
 Bit 5 – 0 
 Bit 6 – 0 
 Bit 7 – 0 

 
Byte 124  Reserved  - always 0 

 
Byte 125  Number of Pings Averaged 

  0 to 25 
 

Bytes 126-127 Center Ping Time Offset  – The Sonar Ping Interrogation Timestamp (Bytes 8-19, 20-28 and 112-
116) is the timestamp for the current ping. But due to ping averaging, the ping time of the center 
ping (of a group of averaged pings) may be required (i.e. for roll stabilization). The Center Ping 
Time Offset is the time difference between the center ping interrogation and the current ping 
interrogation. 

 
Byte 126 Byte 127 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Center Ping Time Offset (in units of 100 microsecon ds) 

 
Center Ping Time   = Sonar Ping Interrogation Times tamp –   

Center Ping Time Offset +  
Ping Latency 
 

 Note: Profile data from the current ping should be used when subtracting the Center Ping Time 
Offset. 

 
Bytes 128-129  Azimuth Head Position   

 
Byte 128 Byte 129 

7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
0-1199 

 
Bytes 130-133  Estimated Heave – 4 byte single precision float 
 

Byte 130 Byte 131 Byte 132 Byte 132 
7-0 7-0 7-0 7-0 

Estimated Heave (meters)  

 
Bytes 134-137  Depth – from depth sensor 
 

Byte 134 Byte 135 Byte 136 Byte 137 
Depth  
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Bytes 138 - 255  Reserved  - always 0 
 
START OF XYZ POINTS (2 bytes/point) 
 
Bytes 256 – (256 + 14 * Beams) 
 

Byte X Y Z Intensity Beam  
256 4 Byte Float 4 Byte Float 4 Byte Float 2 Bytes 0 
270     1 
284     2 

      .   .  .  .          .  . 
      .   .  .  .          .  . 
      .   .  .  .          .  . 

256 + 
14 * Beams -14 

    N-1 

 
 

256+14*480 = 6720 bytes => 6976 Bytes max 
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Appendix H – Sonar Ethernet Specification (V1.01)  
 
OVERVIEW 
 
The Model 837 DeltaT Sonar Head communicates over an Ethernet communications link. To interrogate the head 
and receive echo data, a command program sends a Switch Data Command string to the sonar head. When the 
Switch Data command is accepted, the sonar head transmits, receives and sends one packet of echo data back to 
the command program. The command program must interrogate the sonar head multiple times in order to receive 
all packets of echo data before the data can be processed. 
 
Unless otherwise specified, the DeltaT sonar head will have a statically assigned IP Address of 192.168.0.2 . 
 
 
SWITCH DATA COMMAND  
 
The head accepts 27 bytes of switch data from the command program and must see the switch data header (2 
bytes: 0xFE and 0x44 HEX) in order to process the switches. The head will stop accepting switch data when it 
sees the termination byte (0xFD HEX). The termination byte must be present for the head to process the switches. 
 
 
Table 8 – Model 837 Switch Data Command To Sonar Head 
Byte # Description 

0 – 7 0xFE 0x44 Head 
ID 

Range Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

8 – 15 Start 
Gain 

Reserved 
1 

Reserved 
10 

Reserved 
0 

Reserved 
0 

Packet 
Number 

Pulse 
Length 

Reserved 
0 

16 – 23 External 
Trigger 

Ext Trig. 
Delay HI 

Ext Trig. 
Delay LO 

Data 
Points 

Data 
Bits 

Reserved 
0 

Reserved 
0 

Reserved 
0 

24 – 26 Switch 
Delay 

Freq- 
uency 

Term. 
0XfD 

 
BYTE DESCRIPTIONS 
 
Note: All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix. 
 
Byte 0  Switch Data Header (1st Byte)  
  Always 0xFE (254 decimal) 
 
Byte 1  Switch Data Header (2nd Byte)  
  Always 0x44 (68 decimal) 
 
Byte 2  Head ID 
  0x10 
 
Byte 3  Range  
  5     =  5m 
  10   =  10m 
  20   =  20m 
  30   =  30m 
  40   =  40m 
  50   =  50m 
  60   =  60m 
  80   =  80m 
  100 =  100m 
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Bytes 4 - 7 Reserved 
Always 0 
 

Byte 8  Start Gain  
  0 to 20dB in 1dB increments 
 
Byte 9  Reserved  
  Always 1 
 
Byte 10  Reserved  
  Always 10 
 
Bytes 11-12 Reserved 
  Always 0 
 
Byte 13 Packet Number Request 
 0 to 7    – for 8000 data point mode 
  0 to 15  – for 16000 data point mode 

When the packet number request is 0, the sonar head will transmit, receive and send 
the first 1000 bytes of echo data (the ‘0’ packet). The packet number request should 
then be incremented so that the sonar head will return the next 1000 bytes of echo 
data (the ‘1’ packet). The sonar head does not transmit or receive if the packet 
number request is greater than 0. The packet number request should be incremented 
each time until the total number of echo data bytes have been returned. The packet 
number request should always follow the 0 to 7 (or 0 to 15) sequence. 

 
Byte 14  Pulse Length 
  Length of acoustic transmit pulse. 
   1-100 � 10 to 1000 µsec in 10 µsec increments 
   Byte 14 = pulse_length_in_microseconds / 10 
 
  The following pulse lengths are recommended for each range: 
 
  5m: 30µs 
  10m: 60µs 
  20m: 120µs 
  30m: 180µs 
  40m: 240µs 
  50m: 300µs 
  60m: 360µs 
  80m: 480µs 
  100m: 600µs 
 
Byte 15  Reserved  
  Always 0 
 
The following External Trigger Control bytes are va lid only for DeltaT Sonar Heads supplied with the 
External Trigger Hardware Option. 
 
 
Byte 16  External Trigger Control 
   Bit0: Edge: 0 = NEG, 1 = POS 
   Bit1: Enable: 0 = Disable, 1 = Enable 
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Byte 17-18 External Trigger Transmit Delay 
  Delay from external trigger to sonar head transmit pulse 
 

Byte 17 Byte 18 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
0 to 10000 (in 100 µsec increments)  

 
Byte 19  Data Points 

8 - 8000 data points are returned by the head. The return data will have an ASCII 'IUX' header. 
 
16 - 16000 data points are returned by the head. The return data will have an ASCII 'IVX' header. 

 
Byte 20  Data Bits  
  Resolution (number of data bits) of the returned echo data 
  8 - Data width = 8 Bits, 1 data point per byte 
 
Bytes 21-23 Reserved  
  Always 0 
 
Byte 24  Switch Delay 
  The head can be commanded to pause (from 0 to 500ms) 
  before sending its return data to allow the commanding program 
  enough time to setup for the return of the data. 
  0 to 250 in 2ms increments 

Byte 24 = delay_in_milliseconds/2 
 
Byte 25  Frequency 
  86 = 260khz 
 
Byte 26  Termination Byte  
  The head will stop looking for Switch Data when it sees this byte. 
  Always 0xFD (253 decimal) 
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SONAR RETURN DATA 
 
For every Switch Data Command, the head returns a 32 Byte header, 1000 bytes of echo data and a terminating 
byte value of 0xFC. The total number of bytes  (N) returned will be 1033. For IUX data, a total of 8 Switch Data 
Commands are required to receive the full 8000 data points from the sonar head. For IVX data, a total of 16 
Switch Data Commands are required to receive the full 16000 data points from the sonar head. 
 
Table 9 – Model 837 Sonar Head Return Data 

Byte # Description 
0 - 5 ASCII 

'I' 
ASCII 

'U' or ‘V’ 
ASCII 

'X' 
Head 

ID 
Serial 
Status 

Packet 
Number 

6 - 11 Version Range Reserved 
0 

Reserved 
0 

Data Bytes 
(HI) 

Data 
Bytes 
(LO) 

12 - 16 Ext Trig. 
Status 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

17 - 21 Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

22 - 26 Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

27 - 31 Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

32 – 
1031 

Echo Data 
1000 Bytes 

1032 Term. 
0xFC 

 
 
BYTE DESCRIPTIONS 
 
Note: All Byte values are shown in decimal unless noted with a '0x' prefix. 
 N = total number of return bytes 
 

Byte 0 - 2 Imagenex Return Data Header  
  ASCII 'IUX' or ‘IVX’ 
  'I' = 0x49, 'U' = 0x55', ‘V’ = 0x56, 'X' = 0x58 
 
  ASCII 'IUX' 
  In response to a Switch Data Command with Data Points = 8 
  N = 1033, (32 Header bytes, 1000 Data bytes, 1 Terminating byte) 
  8 Switch Data Commands are required with Packet Number 
  Request incrementing from 0 to 7 in order to receive all 8000 data 
  bytes from the sonar head. 
 
  ASCII 'IVX' 
  In response to a Switch Data Command with Data Points = 16 
  N = 1033, (32 Header bytes, 1000 Data bytes, 1 Terminating byte) 
  16 Switch Data Commands are required with Packet Number 
  Request incrementing from 0 to 15 to receive all 16000 data bytes 
  from the sonar. 
 
Byte 3  Head ID 
  0x10 
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Byte 4  Serial Status  
  Bit 0 - 1 
  Bit 1 - 1 = Internal Test 
  Bit 2 - 0 
  Bit 3 - 0 
  Bit 4 - 0 
  Bit 5 - 0 
  Bit 6 - 1 = Switches Accepted 
  Bit 7 - 1 = Character Overrun 
 
Byte 5  Packet Number  
  0-7 for ‘IUX’ data 
  0-15 for ‘IVX’ data 
 
Byte 6  Firmware Version  
  0x00 – 12 Header bytes, 8000 Data bytes, 1 Terminating byte 
  0x01 – 32 Header bytes, 1000 Data bytes, 1 Terminating byte 
  using Packet Numbers 0 through 7 
  0x02 – add 16000 Data byte ‘IVX’ mode, Packet Numbers 0 
  through 15 
 
Byte 7  Range  
  5     =  5m 
  10   =  10m 
  20   =  20m 
  30   =  30m 
  40   =  40m 
  50   =  50m 
  60   =  60m 
  80   =  80m 
  100 =  100m 
 
Byte 8  Reserved  
  Always 0 
 
Byte 9  Reserved  
  Always 0 



 

Document Number: 430-024-00                                                                                                                                                     Page 71 of 83 

Byte 10 - 11 Data Bytes  
  Number of Echo Data Bytes returned for current packet 
 

Byte 10 Byte 11 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Data Bytes (HI) Data Bytes (LO) 

 
  Data Bytes = (Byte 10 << 8) | Byte 11 
 
Byte 12  External Trigger Status  
  Bit 0 - 0 = External Trigger Not Supported 
     1 = External Trigger Supported 
  Bit 1 - 0 = External Trigger is configured as an Output 
     1 = External Trigger is configured as an Input 
  Bit 2 - 0 
  Bit 3 - 0 
  Bit 4 - 0 
  Bit 5 - 0 
  Bit 6 - 0 
  Bit 7 - 0 = Transmit occurred after 100ms timeout (no trigger found) 

  1 = Transmit occurred after trigger (trigger found) 
Byte 13 - 31 Reserved  
  Always 0 
 
Byte 32-1031 Echo Data     -  1000 Bytes of data for current packet (proprietary format) 
 
Byte 1032 Termination Byte  
  0xFC 
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Appendix I – Azimuth Drive Ethernet Specification ( V1.02) 
 
OVERVIEW 
 
The Model 837 Azimuth Drive communicates over a 10Mbps (10BaseT) Ethernet data transmission line. To 
interrogate the drive and receive sensor data, a “Switch Data Command” string is sent via an Ethernet command 
program. When the switch data command is accepted, the device moves to a new step angle, transmits, receives 
and sends its return data back to the command program. 
 
SWITCH DATA COMMAND  
 
The device accepts up to 27 bytes of switch data from the Ethernet interface and must see the switch data header 
(2 bytes: 0xFE and 0x46 HEX) in order to process the switches. The header bytes must be present for the device 
to process the switches. 

 

Table 10 - Model 837 Azimuth Drive Switch Data Command From Surface. 

Byte # Description 
0 – 7 0xFE 0x46 Head 

ID 
Reserved 

0 
Reserved 

0 
Reserved 

0 
Reserved 

0 
Reserved 

0 
8 – 15 Reserved 

0 
Reserved 

0 
Reserved 

0 
Azimuth 

LO 
Azimuth 

HI 
Reserved 

0 
Reserved 

0 
Reserved 

0 
16 – 23 Reserved 

0 
Reserved 

0 
Reserved 

0 
Reserved 

0 
Reserved 

0 
PRH 

Command 
Reserved 

0 
Calibrate 

24 - 26 Switch 
Delay 

Reserved 
0 

Term 
0xFD 

 
BYTE DESCRIPTIONS 
Note: All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix. 
 
Byte 0  Switch Data Header (1st Byte)  
  Always 0xFE (254 decimal) 
 
Byte 1  Switch Data Header (2nd Byte)  
  Always 0x46 (70 decimal) 
 
Byte 2  Head ID 
  Always 0x1F 
 
Byte 3-10 Reserved  
  Always 0 
 
Byte 11-12 Azimuth Step Angle (LO and HI) 

0 to 1199 (-180.0 Deg to +179.7 Deg) in 0.3 Degree steps. 
Azimuth Step Angle = (angle_in_degrees+180)/0.3 
0 = -180.0 Degrees 
300 = -90.0 Degrees 
600 = 0 Degrees 
900 = 90 Degrees 
1199 = 179.7 Degrees 
 
Byte 11 = Azimuth Step Angle & 0x7F 
Byte 12 = (Azimuth Step Angle & 0x3F80)>>7 
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Bytes 13 - 20 Reserved 
  Always 0 
 
Byte 21  PRH Command  
  for MicroStrain 3DM-GX1 Pitch / Roll / Heading sensor 
  0x00 – Don’t interrogate PRH sensor 
  0x02 – Start compass calibration 
  0x03 – Stop compass calibration 
  0x04 – Start Pitch / Roll calibration 
  0x05 – Stop Pitch / Roll calibration 
  0x80 – Output gyro stabilized Euler angles 
 
Byte 22  Reserved 
  Always 0 
 
Byte 23  Calibrate 
  0 = Normal Operation 
  1 = Calibrate Azimuth Drive Motor (move to 0º) 
 
Byte 24  Switch Delay 
  The head can be commanded to pause (from 0 to 500 msec) 
  before sending its return data to allow the commanding program 
  enough time to setup for the return of the data. 
  0 to 250 in 2 msec increments 

Byte 24 = delay_in_milliseconds/2 
 
   DO NOT USE A VALUE OF 253    

 
Byte 25  Reserved 
  Always 0 
 
Byte 26  Termination Byte  
  The head will stop looking for Switch Data when it sees this byte. 
  Always 0xFD (253 decimal) 
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AZIMUTH RETURN DATA 
 
Every shot, the Azimuth drive returns the required information depending on the command it receives, an error 
status, and the Sequence Number. The total number of bytes  returned will be 40. 
 

Table 11 - Model 837 Azimuth Drive Return Data. 

Byte # Description 
0 – 7 ASCII 

'I' 
ASCII 

 'A' 
ASCII 

'X' 
Head 

ID 
Command 

Status 
Reserved 

0 
Version Reserved 

0 
8 – 15 Reserved 

0 
Reserved 

0 
Azimuth 

(LO) 
Azimuth 

(HI) 
Reserved 

0 
PRH 

Status 
Pitch 
(LO) 

Pitch 
(HI) 

16 – 23 Roll  
(LO) 

Roll 
(HI) 

Heading 
(LO) 

Heading 
(HI) 

Timer 
(LO) 

Timer 
(HI) 

Reserved 
0 

Reserved 
0 

24 - 31 Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

32 - 39 Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Reserved 
0 

Term 
0xFC 

 
BYTE DESCRIPTIONS 
 
Bytes 0 - 2 Imagenex Return Data Header  
  ASCII 'IAX' 
  'I' = 0x49, 'A' = 0x41, 'X' = 0x58 
 
Byte 3  Head ID 
  Always 0x1F 
 
Byte 4  Command Status 
 

Bit  Value Description  

0 0 Adjust Step Successful 

 1 Adjust Step Error 

1 0 Start Compass Calibration Successful 

 1 Start Compass Calibration Error 

2 0 Stop Compass Calibration Successful 

 1 Stop Compass Calibration Error 

3 0 Pitch and Roll Calibration Successful 

 1 Pitch and Roll Calibration Error 

4 0 Send Gyro Stabilized Euler Angles Successful 

 1 Send Gyro Stabilized Euler Angles Error 

5 0 Motor Calibration Successful 

 1 Motor Calibration Error 

Others 0 Reserved 
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Byte 5  Firmware Version 
  0 = DAz_2Aa -> DAz_2Ad 
  1 = DAz_2Ae 
 
Bytes 6 - 9 Reserved  
  Always 0 
 
Bytes 10 - 11 Azimuth Angle  
 

Byte 5 Byte 6 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
0 Azimuth (LO) 0 Azimuth (HI) L 

 
Azimuth Angle = 0.3 * ( [(Byte 6<<7) | (Byte 5)] -600), in degrees 

 
Byte 12  Reserved  
  Always 0 
 
Byte 13  Pitch / Roll / Heading Sensor Status 
  0 = No sensor installed 
  1 = MicroStrain 3DM-GX1 
 
Bytes 14-15 Pitch 
  These two bytes contain the Gyro-Stabilized Euler Pitch Angle from the     
  Orientation Sensor. 
 

Byte 12 Byte 13 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Pitch (LO) Pitch (HI) 
 
  Pitch Angle  = -32768 -> 32767 => -180° -> +180° 
     
    = [(Pitch(Hi)<<8) | Pitch(Lo)] * 360 
             65536 
 
 
Bytes 16-17 Roll 
  These two bytes contain the Gyro-Stabilized Euler Roll Angle from the     
  Orientation Sensor. 
 

Byte 12 Byte 13 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Roll (LO) Roll (HI) 
 
  Roll Angle  = -32768 -> 32767 => -180° -> +180° 
     
    = [(Roll(Hi)<<8) | Roll(Lo)] * 360 
            65536 
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Bytes 18-19 Heading 
  These two bytes contain the Gyro-Stabilized Euler Yaw Angle from the     
  Orientation Sensor. 
 

Byte 12 Byte 13 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Yaw (LO) Yaw (HI) 
 
  Yaw Angle  = -32768 -> 32767 => -180° -> +180° 
     
    = [(Yaw(Hi)<<8) | Yaw(Lo)] * 360 
             65536 
 
Bytes 20-21 Timer  
  These two bytes contain the Timer output from the Orientation Sensor.     
  This counter is incremented every 6.5536ms.  
 

Byte 12 Byte 13 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 

Timer (LO) Timer (HI) 
 
   Timer = 0 -> 65536  
     
    = [(Timer(Hi)<<8) | Timer(Lo)]  
 
Bytes 22-38 Reserved  
  Always 0 
 
Byte 39  Termination Byte  
  Always 0xFC (253 decimal) 
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Appendix J – GPS String Formats for DeltaT.exe  
 
 
GLL: G eographical Latitude and Longitude (Ship's Position) 
 
$GPGLL,ddmm.xxxxx,N,dddmm.xxxxx,W<CR><LF> 
 
Where: 

• dd = Degrees 
• mm = Minutes 
• xxxxx = Decimal Minutes 
• N = North or S = South 
• W = West or E = East 

 
*Note: if using GPGLL string, use GPVTG for ship’s speed and heading 
 
 
VTG: Vector Track and Ground Speed (Ship's Speed SOG and Heading) 
 
$GPVTG,ttt.t,T,mmm.m,M,nn.n,N,kk.k,K<CR><LF> 
 
Where: 

• ttt.t = Track in Degrees (True) 
• mmm.m = Track in Degrees (Magnetic) 
• nn.n = Ground Speed (Knots) 
• kk.k = Ground Speed (Km/Hr) 

 
 
GGA: Geographical (Ship's Position) 
 
$GPGGA,uuuuuu.uu,ddmm.xxxxx,N,dddmm.xxxxx,W,q,s,hhh,aaa,M,gggg,M<CR><LF> 
 
Where: 

• uuuuuu.uu = UTC of Position 
• dd = Degrees 
• mm = Minutes 
• xxxxx = Decimal Minutes 
• N = North or S = South 
• W = West or E = East 
• q = Quality Indicator (0 = GPS not available, 1 = GPS available) 
• s = Number of satellites being used 
• hhh = Horizontal dilution of precision (HDOP) 
• aaa,M = Antenna Height in Meters 
• gggg,M = Geoidal Height in Meters 

 
*Note: if using GPGGA string, use GPVTG for ship’s speed and heading 
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RMC: (Ship's Position) 
 
$GPRMC,tttttt,A,ddmm.xxxxx,N,dddmm.xxxxx,W,kk.k,ccc.c,ddmmyy,vv,E<CR><LF> 
 
Where: 

• tttttt = UTC Time 
• A = Status (A = valid, V = invalid) 
• dd = Degrees 
• mm = Minutes 
• xxxxx = Decimal Minutes 
• N = North or S = South 
• W = West or E = East 
• kk.k = Speed over Ground in knots 
• ccc.c = COG (Track) in Degrees True 
• ddmmyy = Date (day, month, year) 
• vv = Variation sense (E = East, W = West) 

 
*Note: GPVTG is not required when using the GPRMC string 
 
 
 
Serial Port Settings: 
 
4800bps, No Parity, 8 Data Bits, 1 Stop Bit 
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Appendix K – Beam Output Format (83B)  
 
 
After each sonar ping, the following bytes are output via Ethernet to “IPAddress_Output1” as initialized in the 
DELTAT.INI configuration file. The total number of bytes ‘N’ for each ping will vary depending on the number of 
beams used. 
 
NOTE: as of this writing, number of beams is limite d to 120 
 

Byte # Byte Description 
0-255 Header  (256 bytes) 
256-nnnnn  Beam Output for current ping  (500 range bins / beam) 

nnnnn  = 256 + (500*number_of_beams) – 1 
 
 
HEADER 
Bytes 0 through 255 contain the following Header  information: 
 
Byte 0  ASCII '8'  
Byte 1  ASCII '3'  
Byte 2  ASCII 'B' 
 
Byte 3  83B Version  
   2 = v1.02 
 
Bytes 4-6 Total Bytes ‘N’  - number of bytes that are output for this ping 
 

Byte 4 Byte 5 Byte 6 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
N = 256 + (500*number_of_beams) 

 
Byte 7  Reserved  - always 0 
 
Bytes 8-19 Date – system date, null terminated string (12 bytes) 
   "DD-MMM-YYYY" 
 
Bytes 20-28 Time  – system time, null terminated string (9 bytes) 
   "HH:MM:SS " 
 
Bytes 29-32 Hundredths of Seconds  – system time, null terminated string (4 bytes) 
   ".hh " 
Bytes 33-46 GPS Ships Position Latitude  – text string (14 bytes)“ _dd.mm.xxxxx_N ” 

• dd = Degrees 
• mm = Minutes 
• xxxxx = Decimal Minutes 
• _ = Space 
• N = North or S = South 
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Bytes 47-60 GPS Ships Position Longitude  – text string (14 bytes) 
• “ddd.mm.xxxxx_E ” 
• ddd = Degrees 
• mm = Minutes 
• xxxxx = Decimal Minutes 
• _ = Space 
• E = East or W = West 

 
Byte 61  GPS Ships Speed  
   Speed = (Byte 61)/10 in knots 
 
Bytes 62-63 GPS Ships Heading 
 

Byte 62 Byte 63 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Heading * 10 (in degrees) 

 
Bytes 64-65 Pitch Angle (from Orientation Module)  
 

Byte 64 Byte 65 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
P (Pitch Angle*10) + 900 

 
   If 'P' = 0, Pitch Angle = 0 degrees 
   If 'P' = 1, Pitch Angle = [[((Byte 64 & 0x7F)<<8) | (Byte 65)]-900]/10 
 
Bytes 66-67 Roll Angle (from Orientation Module)  
 

Byte 66 Byte 67 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
R (Roll Angle*10) + 900 

 
   If 'R' = 0, Roll Angle = 0 degrees 
   If 'R' = 1, Roll Angle = [[((Byte 66 & 0x7F)<<8) | (Byte 67)]-900]/10 
 
Bytes 68-69 Heading Angle (from Orientation Module)  
 

Byte 68 Byte 69 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
H Heading Angle*10 

 
   If 'H' = 0, Heading Angle = 0 degrees 
   If 'H' = 1, Heading Angle = [((Byte 68 & 0x7F)<<8) | (Byte 69)]/10 
 
Bytes 70-71 Beams  
 

Byte 70 Byte 71 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Number of Beams 
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Bytes 72-73 Samples Per Beam  
 

Byte 72 Byte 73 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Number of Samples Per Beam 

 
Bytes 74-75 Sector Size  
 

Byte 74 Byte 75 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Sector Size (in degrees) 

 
Bytes 76-77 Start Angle  (Beam 0 angle) 
 

Byte 76 Byte 77 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
[Start Angle (in degrees) + 180] * 100 

 
 
 
 
 
 
 
 
 
 
 
 
Byte 78  Angle Increment 
   Angle spacing per beam = (Byte 78)/100 in degrees 
 
Bytes 79-80 Acoustic Range  
 

Byte 79 Byte 80 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Acoustic Range (in meters) 

 
Bytes 81-82 Acoustic Frequency  
 

Byte 81 Byte 82 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Acoustic Frequency  (in kHz) 

 
Bytes 83-84 Sound Velocity  
 

Byte 83 Byte 84 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
V Sound Velocity (in meters/second) * 10 

 
   If 'V' = 0, Sound Velocity = 1500.0 m/s 
   If 'V' = 1, Sound Velocity = [((Byte 83 & 0x7F)<<8) | (Byte 84)]/10.0 
 

 Start Angle  
 -59.5 Degrees 
    Beam ‘0’ 

+59.5 Degrees 
   Beam ‘n’ 

 Sector Size 
120 Degrees 
 
      0 Deg 

Example: 
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Bytes 85-86 Range Resolution  
 

Byte 85 Byte 86 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Range Resolution (in millimetres) 

 
Bytes 87-88 Pulse Length  
 

Byte 87 Byte 88 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Pulse Length (in microseconds) 

 
Bytes 89-90 Profile Tilt Angle  (mounting offset) 
 

Byte 89 Byte 90 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Profile Tilt Angle (in degrees) + 180 

 
Bytes 91-92 Repetition Rate  – Time between pings 
 

Byte 91 Byte 92 
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 
Repetition Rate (in milliseconds) 

 
Bytes 93-96 Ping Number  – increment for every ping 
 

Byte 93 Byte 94 Byte 95 Byte 96 
7 – 0 7 – 0 7 - 0 7 - 0 
Ping Number 

 
Bytes 97-99 Reserved  - always 0 
 
Bytes 100-103 Sonar X-Offset  – 4-byte single precision floating point number 
 

Byte 100 Byte 101 Byte 102 Byte 103 
7 – 0 7 – 0 7 - 0 7 - 0 
Sonar X-Offset (in meters) 

 
Bytes 104-107 Sonar Y-Offset  – 4-byte single precision floating point number 
 

Byte 104 Byte 105 Byte 106 Byte 107 
7 – 0 7 – 0 7 - 0 7 - 0 
Sonar Y-Offset (in meters) 

 
Bytes 108-111 Sonar Z-Offset  – 4-byte single precision floating point number 
 

Byte 108 Byte 109 Byte 110 Byte 111 
7 – 0 7 – 0 7 - 0 7 - 0 
Sonar Z-Offset (in meters) 

 
Bytes 112-255 Reserved  - always 0 
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START OF BEAM OUTPUT BYTES (500 range bins per beam ) 
 
Bytes 256-755 Beam 0:  

500 range bins (0-499), intensity value for each bin is 0-255 
 
Bytes 756-1255 Beam 1 

500 range bins (0-499), intensity value for each bin is 0-255 
 
Bytes nnnnn-499 Beam N 
to nnnnn  500 range bins (0-499), intensity value for each bin is 0-2 


